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8:35-8:50 2. Installation + Prerequisites Greg
+ Installation
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+ Debugging an MPI program
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+ PLDT (MPI, OpenMP, UPC tools)
+ Remote Development
11:50- 12:00 8. Other Tools, Wrapup + NCSA HPC WB, Perf and other Tools, Jay/Beth
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Module 1: Introduction

+ Objective
+ To introduce the Eclipse platform and PTP

+ Contents
+ What is Eclipse?
+ What is PTP?

Module 1 1-0

What is Eclipse?

+ A vendor-neutral open-source workbench for
multi-language development

+ A extensible platform for tool integration

+ Plug-in based framework to create, integrate
and utilize software tools

Java C/C++/Fortran Test and
Development Development Performance Parallel Tools
Tools Tools Tools
Platform
User
e Debug Update Help Team

Equinox
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Eclipse Platform

+ Core frameworks and services with which all

plug-in extensions are created

+ Represents the common facilities required by

most tool builders:

+ Workbench user interface

+ Project model for resource management

+ Portable user interface libraries (SWT and JFace)

+ Automatic resource delta management for
incremental compilers and builders

+ Language-independent debug infrastructure

+ Distributed multi-user versioned resource
management (CVS supported in base install)

+ Dynamic update/install service
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4

Plug-ins

Java Development Tools (JDT)

Plug-in Development Environment (PDE)
C/C++ Development Tools (CDT)

Parallel Tools Platform (PTP)

Fortran Development Tools (Photran)

Test and Performance Tools Platform (TPTP)
Business Intelligence and Reporting Tools (BIRT)
Web Tools Platform (WTP)

Data Tools Platform (DTP)

Device Software Development Platform (DSDP)
Many more...
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Eclipse Parallel Tools Platform (PTP)
Coding & Analysis

Launching & Monitoring

Performance Tuning

Debugging
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Parallel Tools Platform (PTP)

+ The Parallel Tools Platform aims to provide a highly
integrated environment specifically designed for parallel
application development

+ Features include:

+ An integrated development environment (IDE) that
supports a wide range of parallel architectures and runtime
systems =

+ A scalable parallel debugger e

+ Parallel programming tools — : o
(MPI/OpenMP) ; " v

+ Support for the integration
of parallel tools P,

+ An environment that simplifies the
end-user interaction with parallel systems

+ http://www.eclipse.org/ptp
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Module 2: Installation

+ Objective
+ To learn how to install Eclipse and PTP

+ Contents
+ System Prerequisites
+ Software Prerequisites
+ Eclipse Installation
+ PTP Installation

Module 2 2-0

About PTP Installation

+ PTP 3.0 isn’t “official” yet. Planned for late Oct.

+ Note: up-to-date info on installing PTP and its
pre-reqgs is available from the release notes:

http://wiki.eclipse.org/PTP/release_notes/3.0

+ This information may supersede these slides
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System Prerequisites

+ Local system (running Eclipse)
+ Linux (just about any version)
+ MacOSX (Leopard)
+ Windows (XP on)

+ Remote system (running/debugging
application)
+ Must be supported by a resource manager
+ Open MPI 1.2+
+ MPICH 2
+ IBM PE & LoadLeveler (AIX or Linux)
+ SLURM (Linux)
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Software Prerequisites

+ Java (1.5 or later)

+ Cygwin or MinGW (for local development on
Windows)

+ Unix make or equivalent
+ Supported compilers (gcc, gfortran, Intel, etc.)
+ Gdb for debugging (or a gdb-like interface)

+ Gcc for building the debugger and SLURM
proxies from source

+ IBM C for building the PE/LoadLeveler proxies
from source
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Java Prerequisite

+ Eclipse requires Sun or IBM versions of Java

+0Only need Java runtime environment (JRE)
+Java 1.5 is the same as JRE 5.0

+The GNU Java Compiler (GCJ), which comes
standard on Linux, will not work!

Module 2 2-4

Eclipse and PTP Installation

+ Eclipse is installed in two steps

+ First, the base Eclipse package is downloaded and
installed

+ Additional functionality is obtained by adding
‘features’

+ This can be done via an "update site’ that
automatically downloads and installs the features

+ Update site archives can be downloaded to install
features offline.

+ PTP requires the following Eclipse features

+ C/C++ Development Tools (CDT)
+ Remote Systems Explorer (RSE) end-user runtime
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Eclipse Packages

+ Eclipse is available in a number of different
packages for different kinds of development

+ Two packages are more relevant for HPC:

+Eclipse Classic

+The full software development kit (SDK), including
Java and Plug-in development tools

+Eclipse IDE for C/C++ developers
+Base Eclipse distribution

+Base C/C++ Development Tools (CDT) (does not
include UPQC)

+ Either is ideal for PTP use

Module 2 2-6

Eclipse Installation

+ The current version of Eclipse is 3.5 (Galileo)
+ PTP 3.0 will only work with this version

+ Eclipse is downloaded as a single zip or
gzipped tar file from
http://eclipse.org/downloads

+ You must download the correct version to suit
your local environment
+ Must have correct operating system version
+ Must have correct window system version

+ Unzipping or untarring this file creates a
directory containing the main executable
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Platform Differences

+ Single button mouse (e.g. MacBook)
+ Use Control-click for right mouse / context menu

+ Context-sensitive help key differences
+ Windows: use F1 key
+ Linux: use Shift-F1 keys

+ MacOS X
+ Full keyboard, use Help key

+ MacBooks or aluminum keyboard, create a key binding
for Dynamic Help to any key you want

+ Accessing preferences
+ Windows & Linux: Window » Preferences...
+ MacOS X: Eclipse»Preferences...

Module 2 2-8

Starting Eclipse

+ Linux
+ From a terminal window, enter

’ <eclipse installation>/eclipse/eclipse &

+ MacOS X
+ From finder, open the eclipse folder where you installed
+ Double-click on the Eclipse application
+ Or from a terminal window
+ Windows
+ Open the eclipse folder
+ Double-click on the eclipse executable

+ Accept default workspace when asked ;
+ Select workbench icon from welcome page § 5
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Specifying A Workspace
+ Eclipse prompts for a workspace location at
startup time

+ The workspace contains all user-defined data
+ Projects and resources such as folders and files

€ Workspace Launcher =%
Select a workspace
Th e p ro m pt Ca n be Eclipse Platform stores your projects in a folder called a
workspace.
turned off
Workspace: || Browse..
(7] Use this as the default and do not ask again
oK | cancel
Module 2
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Eclipse Welcome Page

+ Displayed when Eclipse is run for the first time
[v] Java - Eclipse SDK [=]=]x))
Eile it Refactor Navigate Search Project Run Window Help
@ Welcome X e =8

Module 2




Adding Features

+ New functionality is added to Eclipse using features

+ Features are obtained and installed from an update site
(like a web site)

+ Features can also be installed from a local copy of the
update site (which can be zipped)
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Installing Eclipse Features
from an Update Site

+ Three types of update sites
+ Remote - download and install from remote server
+ Local - install from local directory
+ Archived - a local site packaged as a zip or jar file

+ Eclipse 3.5 comes preconfigured with a link to the Galileo
Update Site

+ This is a remote site that contains a large number of official
features

+ Galileo projects are guaranteed to work with Eclipse 3.5
+ Many other sites offer Eclipse features
+ Use at own risk
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Installing from an Update Site

+ From the Help menu, choose
Install New Software...

(2) Help Contents
@7 Search
Dynamic Help

Key Assist... Shift+Ctri+L
Tips and Tricks...

Report Bug or Enhancement...

Cheat Sheets...

By

Check for Updates

Install New Software...

About Eclipse

Module 2 2-14

Galileo Update Site

Available Software
=

The Galileo site comes
already configured with Eclipse |/ .

Find more software by working with the ‘Available Software Sites preferences,

For example, some of the —
contents of the Galileo site: —s |2 o .

% Dynamic Languages Tookt - iTcl Development Tools  1.0.0.v200906131432-3--90ASSVSLIK2BLC
% Dynamic Languages Tookit - Ruby Development Tools ~1.0.0.420090610-1638-78--E_EKMOINTYIA:
Dynamic Languages Tookt - TCL Development Tools  1.0.0.420090610-1638-7D--EB75QSMRjetC.
ynamic Languages Tookit - XOTcl Development Tools 1.0.0,v20090610-1638-4--_KE777TAS28NCI
ipse C/C++ Development Tools 6.0.0.200906161748

You can get C/C++ Dev. Tools
from the Galileo site, but...

cclpse Jova Development Tois 350 v20090527-2000-TISBFEeFePyvIeAS
 Ecipse XML Editos nd Tols 310,200905240756-THEFMVORTKM-5059
& Jovascrpt Developer T 1114200906091427.77-FGBCCNBC-Betic
. ) ® PHP Devekopment Tods (PDT) SOK Feature 2104200506110930-51-84QACBINLOM
+ Basic tools, does not include UPC b ()54 SOA Development
: b 0o st and perfomance
+ More complete CDT install b 0 v, e, o € Davepment
shown later Oetals
Echpse C/C++ development tools. (Binary runtime and user documentation.)
+ PTP 3.0 needs CDT 6.0.1,
not available yet More.,
S Show any the test versons o avalabe software ) e Rems tha are akeady instaled
2 Group Remms by category Wat s akeady pntated?

¥ Contact all update sites during install to find required software

? Cancel
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Installation: RSE

+ The RSE End-User Runtime should be installed
from the Galileo update site

=] 100 Mobile and Device Development
<+ Eclipse C/C++ DSF gdb Debugger Integration 2.0.0.200906161748
{4 Eclipse C/C++ Memory View Enhancements 1.2.0.200906161748
& Eclipse C/C++ Remote Launch 6.0.0.200906161748
4 Eclipse Pulsar 1.0.0.v200906121354-3--85s733L3F5759DB
4+ Mobile Tools for Java 1.0.0.v200906121354-7V7A7BFEX2XZqZ-IBoXfQ
4+ Mobile Tools for Java Examples 1.0.0.v200906121354-6--BgJ99r9cEJEOYT
4+ Mobile Tools for Java SDK 1.0.0.v200906121354-4--90dCFUGWM49holaAHM-gthf
§* Remote System Explorer User Actions 1.1.100.v200905272300-31A785733L3D7H7933
* Target Management Terminal 3.0.0.v200905272300-7N-FBVC50pb0z0uz45hjchPQEI |,
Module 2 2-16

Installation: CDT

+ PTP 3.0 needs CDT 6.0.1

+ Update site will contain latest version
+ Update site: http://download.eclipse.org/tools/cdt/releases/galileo

+ Install any features you want
+ Omit the testing feature:

| 44+ Eclipse CDT Testing Feature

+ If you want UPC, include:

¥ 44+ Unified Parallel C Support

+ CDT 6.0.1 is due at the end of Sept

e aresdy entates
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++ 0+

+

Installing PTP

In Work with type the PTP update site URL:
http://download.eclipse.org/tools/ptp/releases/galileo/

Click Add...

Enter a name (optional) E —

e.g. “PTP 3.0” e o o i st /
Click OK and the list of features 0 -
on the update S|te W|” be Find more software by working with the ‘Available Software Sit
populated — —
Select all the components you require b (38 Fotrn Devcpmert b ihotran)
Click Next> P femere pevcopment s

Detais

See PTP release notes for most
recent info on installing 3.0

¥ Contact all update sites during install to find required software

+ show only the latest versions of available software (| kide items that are aiready installed

< Group items by category What is already installed?

? Cancel

Module 2

Installing PTP (2)

+ You will be prompted to accept the License terms
+ Accept the License terms
+ Click Finish

+ Restart Eclipse when prompted

Software Updates

It is strongly recommended you restart Eclipse for the changes to
take effect. For some add-ons, it may be possible to apply the
changes you have made without restarting. Would you like to

restart now?

\
4

Module 2
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File Edit Source Refactor Navigate Search Project Run PAPI Window Help
) Wel x xE"
+ Welcome page | === R
informs you of V
Pnes\ltva}:%%tures Overview Go to
workbench
+ Select
workbench icon =
: Parallel Tools Platform
to go to Leam more about PTP, the Paraliel Tools
workbench et —
Yellow
== Parallel Language Development Tools indicates new
ey et OO L features just
installed
»  Workbench basics
Learn about basic Eclipse workbench concepts
S
Module 2 2-20

Installing Additional PTP Components

+ PTP has a number of additional components
depending on the installation

+ Scalable Debug Manager (SDM) - required for all
platforms to support debugging

+ PE and LoadlLeveler proxy — IBM systems only
+ SLURM proxy - systems using the SLURM resource
manager
+ Installation of these components is beyond the
scope of the tutorial

+ See the release notes for details of installing
these components

Module 2 2-21
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Module 3: Working with C/C++

+ Objective
+ Learn how to use Eclipse to develop parallel programs
+ Learn how to run and monitor a parallel program
+ Contents
+ Brief introduction to the C/C++ Development Tools
+ Create a simple application

+ Learn to launch a parallel job and view it via the PTP
Runtime Perspective

Module 3 3-0

Installation recap

+ Download and unzip/untar eclipse

+ Use Help >Install new software to get
+ CDT for C/C++ tools
+ PTP and related tools for Parallel application work
+ Build PTP binary on target machine (local or remote)

+ Launch eclipse!
Run the ‘eclipse’ executable, from icon or from

command line

B
e
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+ The Workbench

Workbench

represents the desktop
development environment
+ It contains a set of tools
for resource management
+ It provides a common
way of navigating through

the resources

+ Multiple workbenches can

be opened at the same

time

Module 3
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Workbench Components

+ A Workbench contains perspectives
+ A Perspective contains views and editors

perspective

editor

Module 3

xxxxxxxx
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Perspectives

+ Perspectives define the layout of views in the
Workbench

+ They are task oriented, i.e. they contain
specific views for doing certain tasks:

+ There is a Resource Perspective for manipulating
resources

+ C/C++ Perspective for manipulating compiled code
+ Debug Perspective for debugging applications

+ You can easily switch between perspectives

Module 3 3-4

Switching Perspectives

+ You can switch
Perspectives by:
+ Choosing the
Window»Open
Perspective menu
option
+ Clicking on the > 5 [Ec/cr

Open Perspective = =
button /’a.m:g 2 LD TS =
o B R o % T
+ Clicking on a %1 suioh

perspective shortcut o siibh
bUttOﬂ ® main(void) : int

- Eclipse SDK
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Available Perspectives

. Window »

+ By defaUIt, certain Open Perspective
perspectives are available —
in the Workbench = Open Perspective x

+ We,” use. [#3 CVS Repository Exploring

%5 Debug
+ C/C++ %8 PTP Debug
+ PTP Runtime 8 PTP Runtime
5 Resource
+ PTP Debug £0 Team Synchronizing
oK ‘ Cancel |
Module 3 3-6

Views

+ The workbench window is
divided up into Views

+ The main purpose of a view is:
+ To provide alternative ways of presenting information
+ For navigation
+ For editing and modifying information

+ Views can have their own menus and tQolbars

+ Items available in menus and toolbars are
available only in that view
+ Menu actions only
. = i 2 R € e Y=
apply to the view o= Outline & B W’ e =]

+ Views can be resized ® main):int

VIEW | view
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Stacked Views

+ Stacked views appear as tabs

+ Selecting a tab brings that view to the
foreground mes o

0!

Module 3 3-8

ACCGSS help Help - Eclipse Platform =B’
+ Help»>Help Contents i T e
+ Help»>Search - Workbench User Guide [2)7 P

- 5@ evelopment User Guide o Sa J (k
+ Help»Dynamic Help e et Sy

Help Contents provides 2@ Ranning 184 Paraliel Envconment ] 0 [0 EOUPSe help system

© parallel Tools Platform User Guide| Browse topics in the Contents frame (&) on the left

detalled help on dlfferent ’ Click on a topic to have it displayed. Use the Back

and Forward buttons to navigate within the history of

Eclipse features viewed topcs
Search allows you to Searching

To quickly locate topics on a particular subject in the
search for help locally, or ocumeriabon ene  query n e Searc 116

H . Use the S h fr () to display the Search
using Google or the Eclipse View, You can ton e SGope o your seaeh by

selecting only the sections you are interested in

web site
- Synchronizing
Dynamic Help shows help Afler you run a search and ind a opic you were
looking for. click either the Refresh / Show Current

related to the current Topic buton () or Show in Table of Contents

H H button () to match the navigation tree with the
context (perspective, view, : 51| cumenttopic. You might aiso e f usefl to
etC ) g = s 1] synchronize after following in-topic links. <
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Switch to C/C++ Perspective

+ Only needed if uewwiﬂnizw
you're not
already in the Py
perspective -

Customize Perspective...

Save Perspective As
Reset Perspective
Close Perspective

Close All Perspectives

Navigation

+What Perspective
am inin?
See Title r

.= Working Sets
Preferences...

C/C++ - MyHelloProject/src/MyHelloProject.c - Eclipse SDK -
—

B

Open Perspective > CVS Repository Exploring

>[5 Resource

Other...

Open Perspective x

Ej CVS Repository Exploring
%5 Debug

28 PTP Debug

888 PTP Runtime

[ Resource
£0 Team Synchronizing

File Edit Sourte=TRefactor Navigate Search Project Run PAPI Window
Module 3 3-10
Project Explorer View
+ Represents user’s data
+ It is a set of user defined
resources L() Project Explorer &3 =0
+ Files ) 2 8
+ Folders b ¥ Binaries
+ Projects b eincludes
+ Collections of files and b & MyCproject.c
folders

+ Plus meta-data

+ Resources are visible in
the Project Explorer View

Module 3

P (= Debug
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Editors

+ An editor for a resource (e.g. a file)
opens when you double-click on
a resource
+ The type of editor depends on the type of the resource
+ .c files are opened with the C/C++ editor
+ Some editors do not just edit raw text
+ When an editor opens on a resource, it stays open across
different perspectives
+ A(rj1 active editor contains menus and toolbars specific to that
editor

+ When you change a resource, an asterisk on the editor’s
title bar indicates unsziyd changes

l¢l *MyCproject.c &2

Module 3 3-12

Source Code Editors

A source code editor is @ & linear_function.c 2 =0
special type of editor for b
manipulating source :

double evaluate(double x)

turns f(x) = 3.0%x + :

COde 2 ¢ dc emicolon to end of next line
Language features are 5 foun) -
highlighted !

Marker bars for showing
+ Breakpoints

+ Errors/warnings
+ Tasks

Location bar for
navigating to interesting

features U " Task tag
Icons: : Warning
() Error
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Preferences

+ Eclipse Preferences allow customization of almost everything

@
code style = +0Open
b General nfigure Pr o o =
b o e Window » Preferences...
< cicat K&R [built-in] I f ”
sopesnce = = +C/C++ preferences allow many
Build Console. - \mport .
Buid variables | Preview: G Profile ‘K&R [built-in]" W O ptl ons
b Debug * profile name: [K&R [bult-in] ]
. sinctuse ot 1| EOHEM X
Environment. u::f point { [ingentation | Braces white Space Control Statements Line Wrapping + COde fOFmattI ng
‘ pubtic
;u::::a »m; {::ulm\; General settings Preview: Show invisible character s etti n g s
Language Mapping } Tab pokcy: Tbsonly v N
b Make double distang Use tabs only for leading indentati . ' (“Code St Ie”)
b New COT project v :u::t X y ’ #include <math.h> y
b Property Pages Se | |y i h h
Tskags o sze Al | | Pt ¢ shown here
Template Defout | %4, P12 e g
XL C/C++ Compile =y Indent
XLCICH+ Languag retsrm sare{e ‘public', protected. ‘private’ within class body

Help

Instalupdate

Java

TP

>
>
>
b Plug-n Development
>
>
>

< Deglarations relative to ‘public’, protected. private’
< Statements within function bady
< Statements within bigcks

Statements within ‘switch body

Remote Systems ¥ Statements within 'case" body.

Remote Tools

¥ ‘brea statements

> RunDebug
b Tasks Declarations within ‘namespace’ definition
> Team Empty fines

2

n

double Point::distance(const Pointé other) const
doubl other. x;

int Point: :comoareX(const Pointé other) const { |~

double distance(const Pointé other) const;
int compareX(const Pointé other) const;

double y:

double dy =y - other.y;

return sqrt(dx * dx + dy * dy);

Ccancel oK

Module 3
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Creating a C/C++ Applicat

Steps:

+ Create a new C project
+ Edit source code

+ Save and build

C/C++ - HelloC/src/HelloC.c - Eclipse SDK - Ihome/beth/ews/tuto
Navigate Search Project

Open File...

Close
Close All

Module 3

o
>

Run PAPI Window Help
C++ Project

Shift+Alt+N >

Ctri+w
Shift+Ctrl+W | [c2] Convert to a C/C++ Project




New C Project Wizard

C Project

Create a new MPI project Cresne € prjec ofslected tpe

+ File»New»C Project
(see prev. slide) e dafutfocaion

+ Name the project focen
‘MyHelloProject’ o

+ Under Project types, under = oo
Executable, select Hello ——p ; ioveémscront €——This is a
World ANSI C Project Y e “Managed Build”

(no makefile req’'d) ¥ s o project

and hit Next S e 1

+ On Basic Settings pagey
fill in information for your
new project (Author 7 sho
name etc.) and hit Next

Makefile project;

OS::[T; Lw:)";vy(XL ") provide your
< Shared Library (XL UPC) .
Makefle project own makefile

ect types and toolchains only if they are supported on the platform

? Next> ) [ cCancel ) (

Module 3

Finish

+

Changing the C/C++ Build
Settings Manually “

Open the project properties
by right-mouse clicking on
project and select
Properties

Open C/C++ Build

Select Settings

Select C Compiler to change
compiler settings

Select C Linker to change
linker settings

It's also possible to change
compiler/linker arguments
Hit OK to close

Module 3




Editor and Outline View

fno C/C++ - MyHelloProject/src/MyHelloProject.c - Eclipse SDK ‘-
+ Double-click on DES[B @ d oK 05 0-Ar 85 4 |
source file in the e e e eas|

Project Explorer
to open C editor

#include <stdio.h>
#include <stdlib.h>

+ Outline view is
shown for file in
editor

ZTasks[@ Properties. X % |bw pi&E 2 B-15-=0

&) IMyMelloProject/src/MyelloProject.c

Module 3 3-18

Content Assist

+ Type an incomplete function name e.g. “get" into the editor,
and hit ctrl-space
+ Select desired completion value with cursor or mouse

o_function(); )

if (get)
return e getioadavg(double *,int) : int
3 — © getpriority(int.id_D : int

© getprogname(void) : const char *
(2. Problems ()| © getrlimitdnt,dimit *) : int
<terminated> Myl © 9etrusage(intrusage ) int
T11Hello World © getsichar %) : char *
© getsubopt(char * *,char * const *,char *22

© getwiFILE *) : int

# aste aliikiini\ Y
TS >

+ Hover over a program T T ] e

element in the source file to | ; "intseitineofi

retuine gettimeofday(struct timeval * __restrict, void * __restrict);
)% e . Press 72" for focus
see additional information L probiems 0 Tasks B Comsle 51~ ropers X % 0x G1EIE
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Create a Launch Configuration

Run Configurations

Ov

L//|\‘ﬁ v G

] Run As >

Create, manage, and run configurations

= Py Configure launch settings from this dialog:

j im Configcrations... i

Type filter text

~ Press the 'New' button to create a configuration of the selected type.

Organize Fayorites.} [C1C/C++ Application

[€.C/C++ Remote Applicat
> Launch Group x

+ Open the run
configuration
dialog Run»
Run Configuratj
Select C/C++
Application
Select the New
button

| —
Filter matched 3 of 12 items.

@

Depending on which flavor of Eclipse you
installed, you might have more choices in
Application types.

Module 3

~ Press the 'Duplicate’ button to copy the selected configuration.
- Press the ‘Delete’ button to remove the selected configuration.
% - Press the Filter' button to configure filtering options.

~ Edit or view an existing configuration by selecting it

Configure launch perspective settings from the Perspectives preference page.

Close

3-20

Complete the Main Tab

+ Ensure that the correct
project is selected

Select the C/C++
Application (executable) if
necessary
+ Search Project... will search
just within the project o
+ Browse will search anywhere
on the local file system
Select Connect process
input/output to a
terminal if desired

+

x|
type fiter text

v [E]C/C++ Application

[ MyHelloProject Debug
C/C++ Remote Application
Launch Group

C
Filter matched 4 of 13 items

P

Module 3

Create, manage, and run configurations

Run Configurations

()

Name: [MyHelloProject Debug

Arguments| 7 Environment | 45 Debugger | &, Source| <" Refresh| [ Common

MyHelloProject (_srowse.
Build Configuration [ Debug

CiC++ Application

~Browse..

Debug/MyHelloProject (“Search project... ) (

¥ Connect process input output to a terminal.

Close

3-21
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+ Enter any program
arguments into the teXt bOX Create, manage, and run configurations

+ Eclipse variables can also be

Complete the Arguments Tab

Run Configurations

©

passed using the
Variables... button

+ Select a different working
directory if desired

Module 3

i Name: 'MyHelloProject Debug
type filter text = -
v Mai 1% Environment| 35 Debugger | %, Source * Refresh| (] Common
v [£C/C++ Application
< MyHelloProject Debug Program 3

[€1C/C++ Remote Applicatic
> Launch Group

(variables... )

Working directory.

¥ Use default

C (__Aoply ) (_Revent
Filter matched 4 of 13 items

0 = Ciose=3 e o

3-22

+ Select Debugger tab

Run Configurations

Create, manage, and run configurations -

-

v

+ Make sure gdb/mi is x[8%-
selected R} e W e R e e S

+ Change where the

HelloProject Debug Debugger: [ gdb/mi
T]C/C++ Remote Application
# Launch Group

program Sh0u|d StOp if/'/swpenmmupn main Advanced.

desired

+ Change any gdb-specific
options if desired
(advanced users only)

The information on the
debugger tab will only be
used for a debug launch

+ Hit the Run button to
launch your program

Module 3

Debugger Options

{ Main  Shared Ubraries

CDB debugger. 9db (" Browse.

GOB command file: gdbinit (" Browse.

Warning: Some commands i this file may interfere with the startup operation of the debugger, for
example “run”.

GDB command set: Standard (Mac 05)

Protocol: m

Verbose console mode

() Use full file path to set breakpoints

C > Apply (" Reven
Filter matched 4 of 13 items

¢
N)
@

12



Viewing Program Output

+ When the program runs, the Console view should automatically
become active

+ Any output will be displayed in this view (stderr in red)

|2 Problems | & Tasks | &l Console 83 =] Properties X% kEEE #Byr5y= 08
<terminated> MyHelloProject Debug [C/C++ Application] /Users/greg/Documents/workspace/MyHelloProject/Debug/M
I11Hello World!!!

Module 3 3-24
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Module 4: Working with MPI

+ Objective
+ Learn how to build and launch an MPI program
+ Explore some of the features to aid MPI
programming
+ Contents
+ Using a version control system (CVS)
+ Building with Makefiles and autoconf
+ MPI assistance features
+ Working with resource managers
+ Launching a parallel application

Module 4 4-0
Creating the Project

+ Configuring version control

+ Checking out the source code

+ Team support

Module 4 4-1




Connecting to

+ Select Window »Open
Perspective» Other...

+ Select CVS Repository

a Repository

Exploring then OK R — =3
ATk fepochoros 30 G~ = O)|(H mstom = =5
0 e
Module 4 4-2
Add CVS Repository
. . . Add a new CVS Repositol
+ nght'C“Ck In the CVS AddanewCVSReo:swlovy::tl"eCVSReposl(ovieswew CVS
Repositories view, then select § -
New » Repository Location... — =
4+ Set Host to the hostname of Repository path: | /CVS/cluster2009 )
remote machine e .
+ Set Repository path to the CVS P coreeereee: =
repository path Connection
. . Connection type: extssh
+ Fill in Username and Password . ........
+ Set Connection type to extssh ST
to use an ssh connection “:"‘“‘“‘°“":j“°“:"““"*
ve password (could trigger secure storage login)
+ Check Save passWord If you Tomanagcyouvpt‘tssv«ovd,plc;scscc Secure Storage'
. Configure connection preferences...
wish to save the password
+ Select Finish
? (__cancel Finish
Module 4 4-3




CVS Repository Exploring

Open the repository in

the CVS Repository 2 [E[E 7B C i 8 ; : =.‘;
view )
Open HEAD to view vy

files and folders in the V231

CVS head rom

Open Branches or
Versions to view CVS
branches or versions
respectively

uBShL1Ll

Right-click on the —rrrem

mpac.dox 1111

repository and select = ==
Task Reposiories G History 5 #|&-718
Refresh Branches... (.- E

0, eclipse.org.
to see all branches and
versions
Module 4 4-4

Check out as an Eclipse Project

+ In CVS Repositories view, right-click :::'Mm ’
on project and select Project» Check =————  CheckOut As...

out As...

i@ Tag as Version...

+ Make sure Check out as a project oo EXEENG.-
configured using the New Project S B
Wizard is selected

Expand All
+ Leave Checkout subfolders o _ % Add to Branch List...
() 0. Check Out As ns...
checked [ creckouts
Select the method of check out Cvs
+ Select Finish o
‘Choose how to check out folder ‘'mpgc-2.3.1'
@ Check out as a project configured using the New Project Wizard
| O Check out as a project in the workspace
™ Checkout subfolders
| @ Next> Goneel ) (@rmhe)

Module 4 4-5




fNOo New Project

Create a C Project

+ The New Project Wizard is used
to create a C project

) o0 " Chroject
+ Enter Project name | crrojea —
+ Under Project Types, select I
Makefile project» Empty
= M Use default location
Project
+ Ensures that CDT will use existing Croose e syt
makefiles ect type : Toolchains
+ Select Finish S5 et o b 2 E1C+s Toc Chan
+ When prompted to switch to the St

C/C++ Perspective, select Yes ¥ Show project types and toolchains only if they are supported on the platform

@ (<max ) (vext> Cance (s )

Module 4 4-6

Building the Application

+ Configuring the project build directory
+ Generating Makefiles

+ Creating a Make Target

+ Running the build

Module 4 4-7




+ 4+ + 4

Create a build directory

This program requires a separate build directory
Select the project in the Project Explorer view
From the File menu, select elect New»Folder...
Make sure the parent folder is correct
Enter “build” as the folder name
Click Finish
® Eclipse m Edit Source Refactor Navigate Search Project Run Window Help
200 CCHTT IR TIN :C. . fojec (meacc
oy s, OpenFile.. 1 C Project
%= & Close BW % Project...
() Project Explorer G ik’ [c-] Convert to a C/C++ Project ﬁ &29
&9 Source Folder
vizg>mpac (s [ Save As...
8 ?::Trlg ¢ Source File
: aTaTIoN n’ Header File
[ config.log * File from Template
| configure @ Class
| configure.
| COPYING X N [ Other... #N
R copving|  Convert Line Delimiters To ¥ \EerEoFERE CAU CereraT PIBTIE T
J LICENSE 1 [are Foundation; either version 2
5 Makefile |
Module 4 4-8

Makefile Project

+ Similar to managed project, but uses custom
Makefile (or other script) to control build

+ User can specify command that will be used to
initiate build

+ Can also specify the directory in which the
build will take place

+ “"Make targets” are used to control type of
build

+ Can switch between managed and un-
managed project

Module 4 4-9




Makefile Project Properties

[ JeNe) Properties for mpac
Right click on project in e e et C/Crs buid
Project Explorer to | eciccowa E etae {Acuve T8) (Wanage Confiratons=-)
bring up properties / Do oprers
Click on C/C++ Build e e i)
for the build settings e
Can change build e o
command if desired ‘
Change the Build ‘ -
location to the build bt drecory [P e s
directory in the project (orkapsce.) (Fiesysem.) (Varabies-.)
(Restore Defaults ) ( Apply
Module 4 4-10

About Makefiles and autoconf

+ Autoconf is a GNU utility often used to create Makefiles
for open source projects
+ Used to generate a configure script

+ Configure is run to generate a Makefile that suits a
particular system configuration

+ Normally only needs to be run once, unless the build
process needs to be changed
+ Run configure using two methods:
+ Manually from an external shell
+ By creating an External Tools Launch Configuration
+ Must refresh Project Explorer whenever file system is
modified outside of Eclipse, such as after running
configure

Module 4 4-11




Generate the Makefiles

800 External Tools C

From the Run menu, select |

External Tc_)olst_xternaI C:i':;::?::e' nrencontarstons
Tools Configurations... |
Create a new Program \ (w:‘% s et )
For Location, click Browse | +a,rogan == Refresh) G Buld| 28 Emaronment| [ Common
Workspace... and find the | WeeAmrmm—" CoE
configure script | Browse Workspace.. ) ( Browse File System... ) ( Variablesor
For Working Directory, | o D
click Browse Workspace... | Siworkspace_loc: /mpac/buld)
and select the build ' (Cerowse Workspace... ) (_8rowse File System... ) (_Variables... )
directory in the project prrom
Click Run and you should
see output in the Console
view ‘ e
In Project Explorer, right- e ——
click and select Refresh to
see the new files that have || riermacned 2 of 3 items
been created @ — -
Module 4 4-12
Create a Make Target
+ Select the project in SDK =)
Make Targets view Y Vs Reposit... F@C/Cr+ |

+ Click on New Make |
Ta I'get iCOn w& Targets 83 =8|

i > ||
+ Enter the desired name S ®moae )

=% MyHelloProjec
of the target " & mvakefioprlec 1
+ Unselect Same as the 81O  Creste Make Target 1
target name and delete Target name: [butd
A\Y H ” Make Target
bu”d \ (=] Sameis the target name
+ This will run the “make” Make target: ||
command with no Build Command
argu ments ™ Use builder settings

Build command:

+ Select OK

Build Settings
™ Stop on first build error
™ Run all project builders

Module 4 (Gl ) o) 4-13




Running the Build

pqc-2.3.1 mpgc.cc 1.1.1.1 - Eclipse SDK

+ Open the project in the &3 $-0-Q O
Make Targets view to G
see the build target i

+ Double-click on the build
target to initiate the build

+ Output from the build will

mpqc.cc 1.1.1.1 8 = 0/ 5= outline

[ 22CVS Reposit... [EC/C++

- Make Targets £3 =0

ici H ; N o » 25 MyHelloProject
be visible in the Console E myaefierraject
2. Problems | ] Tasks | ] Console % Properties| © Progress D x|t B-r3-=0
Impqc]
-c -DHAVE_CONFIG_H -D_REENTRANT -I../../../../../src/1ib -1/Users/greg/Documents/
ehchude —L/Dasessoren/Docmerrervernis e e ermens” B
orkspace/mpac/src/1ib/chemistry/qc/oint3/13301AB.cc | sed 's/Ai3301A8.0/
0 13301A8.d/g"
M -c -DHAVE_CONFIC.
Module 4

MPI Assistance Tools

Added by PLDT (Parallel Lang. Dev. Tools)
feature of PTP

+ MPI Context sensitive help
+ MPI artifact locations

+ MPI barrier analysis

+ MPI templates

Module 4




Context Sensitive Help

+ Click mouse, then press help
key when the cursor is within a MPI_Comm r¥ak(MPI_COMM WORLD, &my_rank
function name et P P, kL Com, )
+ Windows: F1 key S Fik o€ 1 Il thk s 1 e s mied Ut o o
+ Linux: ctrl-F1 key ; =]
+ MacOS X: Help key or LR ¢ &
Help»Dynamic Help Related Topics
. ~ About
+ A he_Ip view appears (Related b (0 s e,
Topics) which shows See also:
additional information B ditor view click here
(You may need to C||Ck on MPI 2 int MPI_Comm_rank{MPI_Comm, int *) Some
'Sglg&rl‘afg)'tor again, to Drep 22 ~ 0 special info
¢l = 7 has been
+ Click on the functhn name to MPI Comm rank added for
see more information - - MPI APIs
+ Move the help view within your | = ™f=mmiom = n
Eclipse workbench, if you like, Retums the rank of the local
. . . ta;km the group associated
by dragging its title tab with a communicator.
Module 4 4-16
Show MPI Artifact o

Select source file; Run
analysis by clicking on
drop-down menu next
to the analysis button
and selecting Show

MPI Artifacts s EE
Markers indicate the ) -
location of artifacts in 7y

b i Includes.

< Bsrc /
\rfN

editor

In MPI Artifact View
sort by any column
(click on col. heading ™
Navigate to source code
line by double-clicking
on the artifact

Run the analysis on
another file and its
markers will be added to
the view

Remove markers via %

o Navigute Seacch Project Run Window Help

\mks 5 Consdle (2. Problems ¥ MPI Artifact View 2

W Show MPI Artifacts
¥ Show OpenMP Artifacts
/i MP] Barrier Analysis

MyMPIprojecysrc/MyMPIpro ect.c - Eclipse SDK

vGv QB [HBvOvQy |OY | B ¥

- 2 el

25 Oui %
R e
o mpih

=o

<) MyMPIproject.c £3
" o]

n Sourca?
dest = 0;

tag = 0;

nessage(100];

u
us status ; stdoh

o stingh

L

WPI_Conn_size (MPI_COILWORLD, &nun_procs); 1
(=]
) G & )

i X3

o calc_piGnt, int)

WPI_Init(&arge, Sargv): © mainint, char'|

TOMTEWIN (PI_COMLIWORLD, &ny_rank);

TR
[ Asitace Filename  ineNo | construct |
» MPI_Bcast MyMPlproject.c 2 Function Call
P MPI_Reduce MyMPlproject.c 37 Function Call
» MPLInit MyMPlproject.c 57 Function Call
»>
» MPI_Comm_size MyMPlproject.c 63 Function Call
» MP1_Send MyMPlproject.c 70 Function Call
P MPI_Recv MyMPiproject.c 75 Function Call
» MPI_Bcast MyMPlproject.c 8 Function Call
» MPI_Finalize MyMPlproject.c o Function Call
Wiitable SmartInsent | 60:18

Module 4




Scices - - Eclipse SOK - C:

Fle Et Refoctor Source Statstcs Nevgate Search Projec

FIE ARG AN A

&5 Project Explorer

t Run Vindow Hep

$-0-Q- &~ O- [ crees

o man(nt, chare) : it

Verify barrier
 cuton 57O o synchronization in C/MPI
s 0| programs

Interprocedural static
analysis outputs:

+For verified programs,
lists barrier statements that
synchronize together
(match)

+ For synchronization
errors, reports counter
example that illustrates and
explains the error

Module 4 4-18
M I I B [ / \ I . .
11 P Barriers £ = 03([2. Problems | ] Tasks | B Console Y/ Barrier Matches § = O (1 Basrier Erors 13 i v=0o
i 7 i 7 || Barrier Matching Set Function
=1
Functon Barrier Matching Set | Function Filename LneNo [~ -] ;’I’W _— maln
Wl i S Wl Barrier 1) Barier MyBarier.c s = :a:;a :a"*'f;;
YA main 1) Barrier 1 Barvier MyBarrier.c 8 g - rerel)
h  main /) Barrier 3 main MyBarrier.c 41 O‘Vrl:olr ek re ofbaTers) man
"h main = WA Barrier2(1)  main MyBarrier.c 31 e
U man YhiBariier 2 main MyBarrier.c 3
WA Barrier = WhBarrier 3(2)  main MyBarrier.c at
/i Barrier 1 Barrier MyBarrier.c 8
/i Barrier 3 main MyBarrier.c 41
Ul Barrier 4(0)  main MyBarrier.c 57
® WhiBarrier 5(1)  main MyBarrier.c 62 -
< SR > < >
- a PR

MPI Barriers view

N\

Simply lists the barriers

Like MPI Artifacts view,
double-click to navigate
to source code line (all

3 views)

Module 4

Barrier Matches view
Groups barriers that
match together in a
barrier set — all
processes must go
through a barrier in the
set to prevent a
deadlock

Barrier Errors view

If there are errors, a
counter-example
shows paths with
mismatched number
of barriers

10



MPI Templates

+Allows quick entry of

common patterns in MPI MPI_Comm_rank(VPT_COMM_WORLD, &rank);
. MPI_Comm_size(MPI_COMM_WORLD, &p);
programming if Crank —- 0){ //naster task
. - printf("Hello From process @: Num processes: %d\n",p);
+Example: MPI send For Gsource - 1; source < s sourceres {
i MPI_Recv(message], 100, MPI_CHAR, source, tag,
receive MPI_COMM_WORLD, &status);
+Enter: mpisr <ctrl- printf("%s\n" message);
space>
+Expands tq => create message
sprintf(message, "Hello from process %d!", my_rank);
dest = 9;
* use strlen+l so that "\@' g ransmitted *

e strl et t
MPI_Send(message, strlen(message)+1, MPI_CHAR,
dest, tag, MPI_COMM_WORLD);

+Eclipse preferences: add more!
+C/C++ > Editor > Templates
+Extend to other common patterns

Module 4 4-20

Running the Program

+ Terminology

+ PTP Runtime Perspective
+ Resource Managers

+ Launch Configurations

Module 4 4-21




Terminology

+ The PTP Runtime perspective is provided for
monitoring and controlling applications

+ Some terminology

+ Resource manager - Corresponds to an instance of
a resource management system (e.g. a job
scheduler). You can have multiple resource mangers
connected to different machines.

+ Queue - A queue of pending jobs

+ Job - A single run of a parallel application

+ Machine - A parallel computer system

+ Node - Some form of computational resource

+ Process - An execution unit (may be multiple
threads of execution)

Module 4 4-22

Resource Managers

+ PTP uses the term “resource manager” to refer to any
subsystem that controls the resources required for
launching a parallel job.

+ Examples:
+ Job scheduler (e.g. LoadLeveler)
+ Open MPI Runtime Environment (ORTE)

+ Each resource manager controls one target system
+ Resource Managers can be local or remote

Module 4 4-23
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About

+ Open using legend icon in
toolbar

PTP Runtime - jo\02:0 - Eclip ®

Module 4

PTP Icons

Resource Manager Icons

@ STARTING

@ STARTED

STOPPING

% STOPPED

+ SUSPENDED

@ ERROR

Machine Icons Node Icons

Soup o e & USER SHARED
& DOWN I pown © OTHER EXCLUSIVE

ALERT E ERROR @ OTHER SHARED

# ERROR 2 UNKNOWN @ PROCESS RUNNING
#  UNKNOWN @ USER EXCLUSIVE & PROCESS TERMINATED
Job Icons Process Icons

© PENDING + STARTING

© STARTED » RUNNING

© RUNNING ¥ EXITED NORMALLY

© TERMINATED | ¥ EXITED WITH SIGNAL

@ SUSPENDED » SUSPENDED

© ERROR ¥ ERROR

@ UNKNOWN % UNKNOWN

4-24

Open PTP Runtime Perspective

Window > Open Perspective > Other...

New Window

Open Perspective | #5 Debug
Show View > | £0 Team Synchronizing

Customize Perspective... Other...
Save Perspective As... \
Reset Perspective

Close Perspective

Close All Perspectives

Navigation >
. Working Sets >
Preferences...
Module 4

(= Open Perspective

| 75 C/C-++ (default)
@2 CVs Repository Exploring
%5 Debug

22 PTP Debug

288 PTP Runtim

[y Resource

59 Team Synchronizing

‘ Cancel

4-25
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PTP Runtime Perspective

£ PTP Runtime - mpitest/mpitest.c - Eclipse SDK EEES
Fle Edit Refactor Navigate Search Project Run Window Help
+ Resource OIS [B}.Josivg 8
f ) Resource Managers &3 = 0|[ (& mpitest.c & =0
managers ViEwW=—» sinclude <rpi.h>
#include <stdio.h>
int
main(int arge, char *argv(])
1 Machines 5 =) int rank;
. . Please select amachine - caran
nit(sarge, Sargu);
* MaChInes view — mjcom’ranz(m’cgmiwnw, &rank) ;
printf(*hi from wd\n*, rank);
WI_Finalize();
exit(e);
}
d d i | Node Attributes Process Info
+ No € etal S Attribute  Value
view
# Jobs 13 =0 /@ console 13 [2. Problems ) Properties & Tasks ©) Error Log =0

Please select ajob No consoles to display at this time.

+ Jobs view ——

Module 4
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File Edit Refactor Navigate Search Project Run Window Help

+ Right-click in Resource 3~ & |- 0= |4
Managers view and select @ Resource Managers 32 oB
Add Resource Manager (Add Resource Manager..

i Machines 2

+ Choose the Open MPI [
Resource Manager Choose Resource Manager Type

Type Select the type of resource manager to use

x]n"

Resource Manager Types:
IBM LoadLeveler
IBM Parallel Environment

+ Select Next> s

Open MPI

®

Module 4

4-27
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800 B + Choose RSE for Remote
Open MPI connection configuration serVIce prOVIder
Enter Open MPI connection information + Choose Remote Iocation or
: ‘ click New... to create a new
| Remote service provider: = RSE ‘v]/ |OcatI0n
| Remote location: [Local 2] ( New.. + Local can be used to run
Multplexing Options applications locally
O None + Some resource managers
Local address: | localhost = Support tunne“ng over ssh
Use port forwarding connections (e.g. Remote
Tools)
+ The port forwarding option
) would be enabled this if it was
©) ( <Back ) ([ Next> ) Cancel ( Finish ) available
Module 4 4-28
8no New Connection i
Select Remote System Type * Choose SSH only fOI' thIS
Connection for SSH access to remote systems :1!': Connectlon
system oype: + Click Next>
| (o fier text )+ Enter Host name of remote
VL‘-(ejeneraI system
2 FTP Only A ..
B tinux + Click Finish
___®SSHOny "
sxUnix Xale) New Connection
#/Windows Remote SSH Only System Connection
Define connection information
Parent profile: Jarrah ]
{
‘,\,’?\ <Back m ( Cancel ) inish Host name: abe.ncsa.uiuc.edu ﬂ
= S—— - Connection name: abe.ncsa.uiuc.edu
! Description:
¥ Verify host name
? <Back ) Next> ) Cancel ) (C Finish )
Module 4 4-29
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Configure the Resource Manager

800

'+ The Open MPI resource

Open MPI tool configuration

Enter information to configure the Open MPI tool

Open MPI version: | Auto Detect )

Tool Commands

V! Use default commands

Launch command:

Debug command:

Discover command: ompi_info -a --parseable
Installation Location

M Use default location

Location:

manager will auto detect
the version and use the
appropriate commands
+ Change only if you're an
expert

+ Click Next>

+ Change the Name or
Description of the
resource manager if you
wish

+ Click Finish

®eno

."?‘; < Back Next > ) j

Module 4

Choose Resource Manager Name and Description

Enter a name and description for the resource manager
¥ Use default name and description:

Name:

Description:

2) ( <Back Next > (" Cancel ) ( Finish ) 4-30

‘n
"l
1l

Starting the Resource Manager

+ Right click on new
resource manager and
select Start resource
manager

+ If everything is ok, you
should see the resource
manager change to green

800 PTP Runtime - mpqc/README - Eclipse SC
|G | %5 0~ Qv Qur |O- |2 | 4~

(+) Resource Managers 83 =8

_(©)Open_MPI@abe.ncsa.uiuc. ~ 1

Add Resource Manager...
Remove Resource Manager
Edit Resource Manager

882 Machines 32 =g
+ If something goes wrong, Please select a machine
it will change to red el
800 PTP 1800 PTP
/ o |35+ 0@ Qv | T oL o 350 O Qe Qv | T
() ResBurce Managers 53 (- Resource Managers 53
(2. Open_MPI@abe.ncsa.uiuc.edu (Open MPI (£ Open_MPi@abe.ncsa.uiuc.edu (Open MPI ¢
Module 4 4-31
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System Monitoring

800 PTP Runtime - mpqc/|
+ Machine status shown in |813-0-8- Q- |O- i |54 8-5- % ¢
Machines VieW (9 Resource Managers 2 =8

+ Node status also shown
Machines view

+ Hover over node to see
node name £8 Machines 52

+ Double-click on node to

» (2) Open_MPl@abe.ncsa.uiuc.edu (Open MPI)

e “()‘v 3 |- =8

Open_MPl@abe.ncsa.uiuc.edu: Open_MPI@abe.ncsa.uiuc.edu - Root [8]

show attributes

- Open_MPI@abe.ncsa.uiuc.edu

o [ [ o o

Node Attributes
Attribute
Name

Node Number
Node State

Process Info

Value
honest2.ncsa.uiu
0

up

Open MPI number 1

Module 4
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Run Configurations

Dx Q.o G
L v | O Create, and run ations ¢
Create a configuration to launch a parallel application in Parallel Perspective \ J)
i Run As > i .
= v Configure launch settings from this dialog:
un Conngurations...

Organize Fayorites..\
[©] C/C++ Application
+ Open the run
configuration
dialog Run»
Run Configuratio
+ Select Parallel

: Parallel Application

# Launch Group x -

- Press the 'New' button to create a configuration of the selected type.

- Press the 'Duplicate’ button to copy the selected configuration.

Press the 'Delete' button to remove the selected configuration.

% - Press the 'Filter' button to configure filtering options.

- Edit or view an existing configuration by selecting it.

Configure launch perspective settings from the Perspectives preference
page.

Appl ication Filter matched 3 of 3 |tem>s
+ Select the New
button ® Close
Depending on which flavor of Eclipse you
installed, you might have more choices in
Application types.
Module 4 4-33
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Complete the Resources Tab

+ In Resources tab,
select the resource
manager you want to
use to launch this job
Enter a value

in the Number of
processes field
Other fields can be
used to specify
resource manager-
specific information

Module 4

800

Create, manage, and run configurations.

@ (Application): Application program is not specified
x| 83

Name: mpac
Application  Synchronize| %> Debugger| ®- Arguments

neso.mu fanager: | Open_MPi@abe.ncsa.uiuc.edu

Launch Attributes

type filter text

v[E1C/C++ Application
©IMyHelloProject Debug
[€1C/C++ Remote Application
& Launch Group
v 3 Parallel Application

Number of processe:
Options
By node
Prefix

By slot | No oversubscribe (| No local

Hosts
Host file:

Host list

Filter matched 6 of 15 items

2

'y Source| 7 Environment 1

Basic Open MPI__ Advanced Open MPI

o/

Close

4-34

Complete the Application Tab

+ Select the
Application tab

Choose the
Application program
(executable) by
clicking the Browse
button

+ Local program:
executable is under
Debug folder in the
project
Remote program:
must copy to remote
machine; navigate to
its location on the
remote machine here

Select Display
combined output in
a console view if
desired

+

Module 4

8,00

Create, manage, and run configurations
@ [Debugger): SOM path is invalid

LILSE A Name: ‘mpac
type filter text

i Resources | ) Application . Synchronize %> Debugger ®* Arguments

v[€1C/C++ Application
© MyHelloProject Debug
[£1C/C++ Remote Application
& Launch Group
v i Parallel Application

Parallel Project
mpac

Application program:

% Source| 8 Environment| "1

w

Browse

— Ju/ac/grw/mpac/bin/mpcq

| Copy executable from local filesystem
‘ Path to the local file

"] Display combined output in a console view

Filter matched 6 of 15 items

2

Browse

Close

4-35
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+ Choose SDM from
the Debugger
dropdown

+ Use the Browse
button to select the
debugger executable

+ If launching remotely,
the debugger
executable must also
be located remotely

address (covered
later)

+ Click on Run to
launch the program

Module 4

800

Complete the Debugger Tab

Run C

+ Select Debugger tab e

d run configurations

Create a configuration to launch a parallel application in Parallel Perspective W

X8B3

type filter text

Name: [mpac
£ Resources

| < MyHelloProject Debug

Debugger.

[E1C/C++ Remote Application

Launch Grou

p

v§-4Parallel Application

+ Set debugger session

Filter matched 6 of

P

) Application Synchronize(5s Debugger ) ®* Arguments % Source P Environment "1
som 2]

# stop at main0 on startup

Debugger Options.

Path to debugger executable:

Julac/grw/pto/bin/sdm C

Browse

Debugger session address:

localhost

15 items

C N R

Aoply Revert )

The debugger settings will not be used until the
application is launched under the debugger

This will be covered in more detail in Module 6
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+ Double-click a
node in machines

view to see which~

m QAo
Open_MPIgab du: Open_} d

Open_MPi@abencsaulucedy o o P

processes ran on
the node

+ Hover over a
process for tooltip
popup

+ Job and processes
shown in jobs

Viewing The Run

PTP Runtime - job0:0 - Eclipse SDK. =

800

» (2)Open_MPi@abe.ncs:

o 30 Qr Qe |O =

2) Resource Managers &2

a.uiuc.edu (Open MPI)

Node Attributes

Atribute Value
Name hone:
Node Number 4
Node State up
Open MP1 number 1
C—

& Jobs 83, £ Jobs List

Open_MPI@abe.ncsa.uiuc.e

Process Info
¥job0:0
stlncsauiu  §job0:1

Q o

du: default;job0 - Root 4]
v

5 EiPTP Runtime 52C/C++
= O[5 Makefile |5 job0:0 22 =0
Process details
PID: 0
Status: EXITED

~ Program output

=0

Starang o W TR T O TR TOT TGy

~Root (8] mpac-2.3.1/src/bin/mpac/sample/newton.in

. MPQC: Massively Parallel Quantum Chemistry \
Version 2.3.1

Machine:  x86_64-unknown-linux-gnu
User:  grw@honestl.ncsa.uiuc.edu
Start Time: Thu Aug 27 21:21:47 2009
Using ProcMessageGrp for message passing (number of nodes =
Usina PthreadThreadGrp for threadina (number of threads = 1)
B Cons 82 [2 Prob| & Prop | ¥ Task @) Error| b Rem | #Rem | = O

Open_MPi@abe.ncsa.uiuc.edu:default:job0 b B

oor: : form_variable_coordinates()
expected 3 coordinates
SymmMolecularCoor: : form_variable. coordinates()
expected 3 coordinates
@ #ea found 2 varicble

Turac/arainpac/share/apac/2.3.1/basis/3-21g kv
Turac/arainoac/share/mpac/2.3 Afvasiss3 2ia kv, (D)
/u/ac/gra/mpqac/share/mpac/2.3.1/basis/sto-3g. kv,

e > <

Module 4
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Viewing Program Output

+ Double-click a
process to see

process detail and

standard output
from the process

+ Console displays
combined output
from all processes

aeno PTP Runtime - job0:0 - Eclipse SDK. e}
3 5308 QO =6+ |8 v = i PTP Runtime TE/C/C++
2) Resource Managers £2 = O)[L Makefile =0
» (2)Open_MPI@abe.ncsa.uiuc.edu (Open MPI) Process detalls
PID: 0
Status: EXITED
— ——| - Program output
i Machines &2 U (1 d G 20 Saruny sy juracgrwmpgeromy g raracrgrwg
Open_MPI@abe iuc.edu: Open_MPI@abe. iuc.edu - Root (8] mpac-2.3.1/src/bin/mpqc/sample/newton.in
Open_MPI@abe.ncsa.uiuc.edu o 1 o o 1 5 o MPQC: Massively Parallel Quantum Chemistry
Version 2.3.1
Machine:  x86_64-unknown-linux-gnu
User:  grw@honestl.ncsa.uiuc.edu
\ Start Time: Thu Aug 27 21:21:47 2009
Using ProcMessageGrp for message passing (number of nodes =
Atributes Process Info Usina PthreadThreadGrp for threading (number of threads = 1). .7
At Value ¥10b0:0

honestl.ncsa.uiu  $job0:1

& Cons 82 [2 Prob | £ Prop| 7 Task @) Error| B Rem | & Rem | = O
Open_MPI@abe.ncsa.uiuc.edu:defaultjob0 0| 0t B r9-
L rmm—
SymnMolecularCoor: : form_variable_coordinates()
expected 3 coordinates
SymaMolecularCoor: : form_varicble_coordinates()
expected 3 coordinates
found 2 variable coordinates
found 9 constant coordinates
found 2 variable coordinates
found @ constant coordinat
Reading file /u/ac/gra/mpac/share/mpac/2.3.1/basis/3-21g kv

Module 4

File Ju/oc/gra/mpac/share/mpac/2. 3 /vasis/3 21 v, (D)
Reading file /u/ac/gra/mpac/share/mpac/2.3.1/basis/sto-3g.kv.

Reading file /u/ac/gra/mpac/share/mpac/2.3.1/basis/sto-3g.kv. &

e

=} a0

4-38
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Module 5: Fortran

+ Objective
+ Learn what Photran is and how it compares to CDT
+ Learn how to create a Fortran MPI application

+ Contents
+ Overview of Photran
+ Module 3 redux (in Fortran)
+ Differences between Photran and CDT
+ Pointers to online documentation for Photran

Module 5

5-0

£ @ VIETNAMESE

TAKE OUT 365-0051

RESTAURANT P@

RESERVED| (R
PARKING




) T MNP

P

i}; \

IDE for Fortran E2iXE
TAKE OUT 365-0051

[~ Fortran - bstrit.f90 - Eclipse Platform "M

File Edit Navigate Search Project Run Window Help

< i >src-line-fitting

» 3 >bstfit.f90 1.1 (ASC|

4 .cvsignore 1.1 (ASCI

jpdl oo MIE A0 MU A A A B - B L CICA e
[ Fortran Projects 32 =0 m =0 g outline 52 =8
B &~ e T T R B W e T
= _module Mdataset (o]
b ESMMFP implicit none DE, ¥ ) Mdataset
~ i§>org.eclipse.photran-sam| ¥ ) Tdataset
fyzorg.eclpse.p P ! Declare a Tdataset type to hold data points o
b < Binaries type :: Tdataset ?  datapt
D (43 src-fixed-form real :: datapt(4,1000) ° npts
integer iionpts
b src-fortran-and-c ) real :: valsum(4) < valsum
b (4 src-gaussi. (x) real s:.valsum(4) °  yalsum
real i1 xysum(3) .
b (f src-includes logical : has_np(2) xysum
D (f src-language-features end type Tdataset “ has_np

end module Mdataset

program BstFitProj

b (i src-modules &
(cil I D]

@  use Mdataset
I

=8
® =

P =S org.eclipse.photran-samples

(@ Make Targets 2

D Ewhatever2

[2. Problems 52
26 errors, 0 warnings, 0 infos

Console Properties

Description

@ Derived type definition has no compong

® Error: Component 'valsum' at (1) already

@ FILE tag must be of type CHARACTER

@ lllegal preprocessor directive

(€1l 1)

(€1l

Photran
* http://www.eclipse.org/photran
* Official Eclipse Foundation project;
part of the Parallel Tools Platform (PTP)
* 20,000 downloads/release (2007)

* Supports Fortran 77, 90, 95, and 2003
* Built on CDT; largely similar to it

* Primary contributor: UIUC

Contrib’s from Intel, IBM, LANL, & others

Module 5
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Fortran - bstfit.f90 - Eclipse Platform

File Edit Navigate Search Project Run Window Help

b ESMMFP

_module Mdataset
implicit none

o) v ¥ O QG B 68 [y | & & | @B~ v §lr © Gv o
[§ Fortran Projects 83 =8 !! bstfit § = B8 5= outline %
g & v | B R e T

¥ i&=org.eclipse.photran-samp

| Declare a Tdataset type to hold data points
type :: Tdataset < datapt
Fortran real :: datapt(4,1000) -
integer i npts .
= (X real valsum(4). valsum
Editor & o real vataun() o yacum
real xysum(3) .
0ut ine s logical 11 has_np(2) xysum
ge-features end type Tdataset “ has_np

¥ 3 >src-line-fitting

b (i src-modules

(@ Make Targets 83

b Ewhatever2

[<m

|@ | ¥ W Mdataset
¥ ) Tdataset

end module Mdataset

>bstfit.f90 1.1 (ASCI|

|y.cvsignore 1.1 (ASCI

program BstFitProj

5]
D]

[~)|® _ use Mdataset
<«

D]
=0 [ Problems

& = 26 errors, 0 warnings, 0 infos

Console Properties

Description

b = org.eclipse.photran-samples . -

@ Derived type definition has no components

® Error: Component 'valsum' at (1) already declared at (2)

@ FILE tag must be of type CHARACTER

@ lllegal preprocessor directive

< () BstFitProj
¥ LoadDataSet
“  ShowDataPoints

© squareDistances [v]

[

Resource

bugl38221.f
bstfit.fo0 D
bugl18974.f

(€1l

I Df(el

bugllBQSl.lE]

Qg

Module 5
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samples/src-fixed-for...
=0
] 2 ' 3 4 5
d format source with context-aware highlighting
integer :: if = 3
integer :: end = 5
character :: endif = "Hello"
if (if .gt. end) then Context-
print *, &
Rendif Aware

endif

Highlighting

Module 5
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" /Fortran - bstfit.fo Eclipse Platform

File Edit Navigate Search Project Run Window Help

(&~ - v xS v -
= 8| & outline % =8
88 71 ed et AR e~
mo - .
D ESMMFP Tl cvs D; < () Mdataset =
¥ & >org.eclipse.photran < ) Tdataset

hold data points

b < Binaries T support ?  datapt

b (] src-fixed-form (4,1000) Y npts

b (f src-fortran-and-c o — (4) “  valsum

b (9 src-gaussi (X real ii.vatsum(4 @ yvalsum
real 11 xysum(3)

b src-includes logical :: has_np(2) @ xysum

P (f src-language-features end type Tdataset “ has_np

v i >src-line-fitting and module Mdataset v () BstFitProj

>bstfit.f90 1.1 (ASCI| ¥ LoadDataSet

program BstFitProj

|y.cvsignore 1.1 (ASCI ¥ ShowDataPoints
b (i src-modules [~)|® _ use Mdataset & “ SsquareDistances |~/
D} <« D} <
(@ Make Targets 83 = B8 [ Problems % . Console Properties % Y =0
o = 26 errors, 0 warnings, 0 infos .
c Description Resource -~/
P S org.eclipse.photran-samples
D Ewhatever2 @ Derived type definition has no components bugl38221.f
® Error: Component 'valsum' at (1) already declared at (2) bstfit.fo0 |
@ FILE tag must be of type CHARACTER bu9118974.f‘
@ lllegal preprocessor directive bugl18961. [~
(€1l )T 1

Module 5

" 'Fortran - bstfit.f9

Ecl

Platform

File Edit Navigate Search Project Run Window Help

jpdl ) MIE A0 MU A A A B - B L CICA e
[ Fortran Projects 32 =0 M = B8 5= outline % =8
g &~ -- T T B W e T
_module Mdataset |m
b ESMMFP implicit none = ¥ W Mdataset =
~ i§>org.eclipse.photran-sam| ¥ ) Tdataset
fyzorg.eclpse.p P ! Declare a Tdataset type to hold data points °
b < Binaries type :: Tdataset ?  datapt
D (4 src-fixed-form real 11 datapt(4,1000) ° npts
integer npts
b src-fortran-and-c ) real :: valsum(4) < valsum
b (4 src-gaussi. o) real :.valsum(4) °  yalsum
real xysum(3) .
b (f src-includes 1 logical : has_np(2) xysum L
D (f src-language-features end type Tdataset “ has_np
< i >src-line-fitting lend modiile Mdataset BstFitProj
LoadDataSet

program BstFitProj

4 .cvsignore 1.1 (ASCI

b (4 src-modules [¥]|® _ use Mdataset
il I D] <

I
Make Targets £% = B [2 Problems 83 . Console Properties

&) Dy 26 errors, 0 warnings, 0 infos

. Description
P S org.eclipse.photran-samples .

D = whatever2 @ Derived type definition has no components

bstfit.Fo0
@ FILE tag must be of type CHARACTER bugl18974.f

@ Error: Component 'valsum' at (1) already declared at (2)

@ lllegal preprocessor directive bug118961.1[,
(o] IND|(ETI ] D)

Module 5




- Debug - sayhello.f30 - Eclipse Platform -0l x|
File Edit Mavigate Project Run Window Help
| 5 - S -0 5 -l ¥R F5| #5pebug TFortran >
' %5 Debug 53 = B[ 9=variables 52 «_Breakpo... ‘ Registers l Memory‘”z =8|
& 0 | = & @i v k| % % % v
[=-3F SayHello-Photran2. 1-win32-g95 [Fortran Local Applice 4 | 7 language
= Cyagwin GDB Debugger (2/15/05 11:32 AM) (Suspe
(=4 Thread [1] {Suspended) —
= 3speak_.474() at sayhello.F30:86 <
= 2 MAIN_{) at sayhello.F30:71 v
< | o[l o Debugging
sayhello, 90
e n I~ (GDB GUI)
2 call RANDOM NUMBER (rand)
if (rand > .7) then
language = 'Greek'
else if (rand > .3) then
language = 'Polish' =l
else
> language = 'Japanese'
end if 2
< | »
‘EConsoIeSﬂ.’r :I‘asks ‘ &H =3 - = 85|
SayHello-Photran. 1-win32-g95 [Fortran Local Application] Debugger Process (2/15/05 11:32 AM)
/eygdrive/c/WINDOUS/systen32/kernel32.dll :I
/eygdrive/c/Documents and Ser.r.ings/draganch/Desktop/ecllpse/workspaee/SayHell(_l
/eygdrive/c/WINDOWS/systen32/advapi3z.dll v
< | »
I Writable SmartInsert | 86:1 |
Module 5 5-8

Using Photran

+ It's just like using CDT...
+ Similar New Project wizards
+ Similar build procedure
+ Similar launch/debug procedure

+ ...but not exactly
+ Configuring fixed vs. free form file extensions
+ Different editor features
+ Different advanced features (Module 7)

Module 5 5-9




Fo rtrah

Switch to Qs Pe

rspective

+ Only needed if /mNewwm::f

you're not |
already in the Open Perspective >
perspective e X

Customize Perspective...
Save Perspective As... )

%> Debug
£Y Team Synchronizing

Reset Perspective...
Close Perspective
Close All Perspectives

\
\
He C/C++

CVS RepYysitory Exploring

+What Perspective | Navigation > || |35 Debug
.. 48 FindBugs

am in in? ¥ e i i

See Title Bar ?;jjava (default)
" 1 Java Browsing

800 ( F?nran >Ecllpse SDK TSJJJVJ Type Hierarchy
3~ Fsv Qv @y Qv |[Fr &9+ [Fv | O~ | | 4=Plug-in Development
Module 5

5-10

Creating a

Steps: Fortran

+ Create a newg project
4+ Edit source code

+ Save and build

& Fortran - Eclipse SDK

(File] Edit Navigate Search Run Project Window Help
Alt+Shift+N » | [F]

New

Open?fe.‘.
Close Ctrl+W | 5
Ctrl+Shift+W | C§

&

Module 5 PTP Tutorial

Application

1 Project...

Fortran Project \

Source Folder
Folder

Source File




Fortran _
New # Project Wizard

Fortran Project

Create a new MPI project
+ File»New »v\w Fortran coeor o seecnd e

(see prev. slide) Project .. ... ...
+ Name the projeC/'::;“"“"“"‘"""
‘MyHelloProject’ There are

+ Under Project types, under “Managed Build”
) o : y Cteanne projects for
} || Fortran too...
..but this is a
Hello World Fortran | Mﬁkef"e project,
Project and hit Next e e
+ On Basic Settings page, Makefile
fill in information for your
new project (Author
name etc.) and hit . , J—
Finish '
Module 5 5-12
Fortran Projects
View
+ Represents user’s data
+ It is a set of user defined . : -
[F| Fortran Projects $3 8
resources ———
+ Files 2 yForranproject |
+ Folders bf;;t" Binaries
. » [ Includes O
+ Projects v (B src
+ Collections of files and > [A) MyFortranProject.f30 |4
folders > & bin X

+ Plus meta-data

+ Resources are visible in
the PHGRAEHANGAS View
Fortran Projects

Module 5 5-13




Editor and Outline View

[ XeXe) Fortran - MyHelloProject/src/MyHelloProject.f90 - Eclipse SDK (=]

+ DOUb|e-C|ICk on 0 O 0|8 ® 308 Q- @6y [y | O £ EgjFortran
. [ Fortran Pr 33 = B |[ ) MyHelloProject.f90 53 = B(8 outline X =]
source file to Vo T SGiee

15 MyHelloProject 5 <Free Form Source>

v use
Sinaries implicit none @ (anonymous)

open & editor

> INGgudes
Fo rtran v (5 sre integer, parameter ::
» 7 MyHelloProject.f50
» & bin integer .
cproject integer 11 my_rank

iip

+ O I . . project integer 11 source
utline view is inceger i dest :
. . integer 1t tag !t fol
he ter(len-LEN) :: ] e
shown for file in GaractarClenli) ++ settose crams s> | oot
editor € 5 o
(2. Problems 52 _[E) Console| [, Fortran Declaration =0
0 items
Description & |Resource Path Location
€ D> | € ) >
v} Writable Insert 1:1
Module 5 5-14

Et Cetera
+ Building (compiling) is identical

not shown in the
Problems view?

+ Right-click on the

o Build All Ctrl+B project in the Fortran
Projects view, and

Window  Help Tip: Are compile errors

Close Project

Build Configurations 4 !
— choose Properties
Build Project
Build Working§ , + Expand Fortran
- Build » Settings
ean...

+ Switch to the Error
Parsers tab

+ Are Photran’s error
parsers checked? If
not, click Check all

+ Click OK and re-build

v Build Automatically

Module 5 5-15




Et Cetera

+ Creating a launch configuration is identical
(Suggestion: Uncheck Stop on startup at main in the Debugger tab)

Tip: Is your binary not
listed when you create a
launch configuration?

+ Right-click on the
project in the Fortran
Projects view, and
choose Properties

+ Expand Fortran
Build » Settings

+ Switch to the Binary
Parsers tab

+ Make sure the parser
for your platform is

checked
PE = Windows
Elf = Linux
Mach-O = Mac OS X
+ Click OK
Module 5

2 Run Configurations

| Create. manage. and run configurations

x o
type Yter text
T\C/Co+ Application

clipse Application
|| ] Fortran Local Application

[¥] FortranOnWindows D:

5 Java Applet

131 Java Application
Ju JUnit

Ju JUnit Plug-in Test
% Launch Group
4 0SGi Framework

Neme: FortranOnWindows Debug

[) Main 9+ Arguments| B Environment| 3

Fortran Application:
Debug/notepad.exe [Search Project..) [ Browse.. |
Project:
FortranOnWindows [ Browse..
Build (if required) before launching
Buld configuration: [Debug v
Enable auto build Disable auto build

© Use workspace settings  Configure Workspace Settings

putto a t

- * Appl; Reyert
Filter matched 10 of 10 items i‘ [L
@ Run [ Close |
PTP Tutorial 5-16

+ Debugging is identical

Et Cetera

+ Launching a parallel application is identical

+ Debugging a parallel debugging is identical

Module 5

PTP Tutorial




Differences (1): MPI Project Wizard

+ In the MPI Hello World C Project,

the MPI compiler is set in the project settings...
(See “Changing the C/C++ Build Settings Manually” in Module 3)

+ ..but in the MPI Hello World Fortran Project,
the MPI compiler is set in a Makefile.

- Makefile g3 =8
.PHONY: all clean

all: MyHelloProject. f90
—OZ -g -0 bin/MyHelloProject \
rc/MyHelloProject. f90
clean:
rm -f bin/MyHelloProject *.mod

Module 5 5-18

Differences (2): Content Assist

+ Content assist is disabled by default.

(So are Declaration View, Hover Tips, Fortran Search, and refactorings.)

You must specifically enable it for your project.

8,00, Properties for MyHelloProject
+ RIght-ClICk on the type filter text Analysis/Refactoring vy v
i i R
project in the Fortran e s To enable Open Declration, Find AllReferences, the Fortran Declaration
B H view, content assist, and refactoring in Fortran programs, check the
PrO_] ects vi ew, an d bBCl:I(‘_‘{e:SBuild following box. A program database (index) will be updated every time
= ! a Fortran file is created or saved.
»C/C++ General
Choose Pro pe rtleS » Fortran Build ™ Enable Fortran analysis/refactoring
+ Expand Fortran» i) Imﬁ" © Enable Fortran Declaration view
H H ™ Enable Fortran content assist (Ctrl+Space)
Analysis/Refactoring Paths and symbols |8
Project References

™ Enable Fortran Hover tips

+ Check Enable Fortran /oo

H H The following specify the paths searched for modules
analysis/refactoring
. These MAY BE DIFFERENT from the settings used by
+ Click OK your compiler to build your project.
Folders to be searched for modules, in order of preference:

+ Close and re-open any /MyHelloProject P

Fortran editors —

@ Cancel ) oK

Module 5 5-19




Differences (3): Source Form

+ Fortran files are either free form or fixed form
+ Determined by filename extension
+ Extensions are set in the workspace preferences

+ Defaults:
Fixed form: .f fix for fpp ftn
Free form: .fO3 .fo5 .fo0 f77

+ Many features will not work if filename
extensions are associated incorrectly

(Outline view, content assist, Fortran Search, refactorings, Open Declaration, ...)

Module 5 5-20

Differences (3): Source Form

Set fixed/free form filename extensions in the preferences
Iam File Edit Refa

About Eclipse SDK

“ 8eno Preferences
Preferences. .. %, .
type filter text Content Types Ly Sy v
¥General . . :
- » Appearance See 'File Associations' for associating editors with file types.
Hide Eclipse SDK ~ 3H Capabilities Content types:
Hide Others #H \ Compare/Patch » Binary File
Show All Content Types Java Class File
= » Editors vText
Quit Eclipse SDK ~ #Q Keys Assembly Source File
- - » Network Connectic »C Source File
Perspectives VFortran Source File .
+ Navigate the tree Search Fortran Source File - Fixed Format 3
G > psecurty L S Y
o Genera starup and shundd | | B1eassocatons:, P
Content Types »Workspace “f03 ® Add
VvAnt ~f77
vEditor *f90
+ EXpa nd Textr Content Assist *.fos5 =
Fortran Source Formatier
- Templates Remov
File Runtime A
. VC/Ct++ Y | Default encoding:
+ Select Fixed or [ XIC
Free Format and @ ( Gancel )
- G
set associations
Module 5 PTP Tutorial 5-21
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Differences (3): Source Form

Outline view displays expected source form of file in editor
(according to the workspace preferences)

g Fortran - FortranOnWindows/test.f30 - Eclipse SDK
File Edit Refactor Navigate Run Search Project Window Help
R Fortran Proj 22 = O|[[F) testf0 £3

GF Outline 52 =0
AR
1% FortranOnWindows <Free Form Source>
(= Debug I P test
[ test.fo0 progzpm test
cproject implicit n_one \
= print *, "Hello"

=] .project

end prpgram tes

| Attempting to open a file
with the “wrong” editor

(right-click »Open With)
[2/ Problems 2 & Console E\;F issues a Warning (]

0 errors, 4 warnings, 0 others

Description Resource Path Le
% Warnings (4 items)
‘ i »

Writable Insert 7:1

Module 5 PTP Tutorial 5-22

For More Information
+ Module 7: Fortran Search, Refactoring

+ Photran online documentation
linked from http://www.eclipse.org/photran

+ User’s Guide
General introduction, basic features

+ Advanced Features Guide
Features requiring analysis/refactoring to be enabled

+ Online tutorial: Compiling and running the

Parallel Ocean Program using Photran and PTP
linked from http://wiki.eclipse.org/PTP/photran/tutorials

Module 5 5-23
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Module 6: Parallel Debugging

+ Objective

+ Learn the basics of debugging parallel programs with
PTP

+ Contents
+ Launching a parallel debug session
+ The PTP Debug Perspective
+ Controlling sets of processes
+ Controlling individual processes
+ Parallel Breakpoints
+ Terminating processes

Module 6 6-0

Launching A Debug Session

@) ime -
Use the drOp-doWn next to 800 PTP Runtime - shallow

the debug button (bug ———— > 2ot
icon) instead of run button

Select the project to launch Debug As >

i Debug Configurations...
The debug launch will use Organize Favorites...
the same number of gortMachines 12 Qalu- @- =0
Open_MPl@abe.ncsa.uiuc.edu: Open_MPl@abe.ncsa.uiuc.edu - Root [40]

processes that the normal

=08
" [c]2 MyHelloProject Debug |

. Open_MPl@abe. .uiuc.ed
launch used (edit the —
Debug Launch 2o [ [ 1 o

Configurationtochange) | ~TEEEEEEEEE

Node Attributes Process Info

Attribute Value
Name nodeQ
Node Number 0
Node State uP
Open MPI number 1

Module 6 6-1




The PTP Debug

Perspective (1)

ano PIP Debug - - Eclipse SDK =
+ Para"el Debug ) |45 0 Qe Qe | O 52 {7 BBPTP Debug EiPTP Runtime TC/C+
view shows Job 8 Parallel Debug 22 > » om0 [RA]o {2+ = 0% Breakpoints 4 Expressions - Variables &2 =a
and processes Qo0 IR
being debugged —*> > < rm}; [0
Zowas I = - |
+ Debug view shows v v:‘;;}‘;we:“;mmA”mm] ; psi 0-16) " ‘
threads and Ca” v P Thread [1) (Suspended) | G
stack for individual
processes =02 ouine & =o
LAY * -
W math.h
+ Source view - o Bl 3 man
shows a current\‘ float  dictoisCriontses 5 workar s void

In;

oat
t 1, j, chunk_size, nxt, prv;

line marker forall "
processes e

S console| 0 Memory| 9] Error Log &2

£ Problems

setup_res() : MPI_Dataty
main(int, char*(])

setup_res() : MP_Dataty
update_global_ds(MP1_C|

Master SOM control

Module 6
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The PTP Debug

Perspective (2)

8no PTP Debug - in.c - Eclipse SOK =
+ Breakpoints view . " - e e v A=
shows breakpoints & =g .
that have been set sra p
(more on this later) seeas. X 33 b1
+ Variables view s —— e S—
shows the current
values of variable%‘th =% owine =a
for the currently e . e
selected process in - =i mnon; ooam

float

dj=tpi/(Floatdn;
3, chunk_s

the Debug view

Outline view (from
CDT) of source
code

L axt, prv;

© console ) Memory @ Error Log £2

L. Problems.

worker0) : void
setup_res() : MPI_Dataty’
o main(int, char*())
© setup_res) : MPI_Dataty
© update_global_ds(MPI_C

Master SDM control

Module 6
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Stepping All Processes

+ The buttons in the 800 PTP Debug - shallow/main.c - Eclips
Parallel Debug v.N* Sl el (=] Ciiiask it
control groups of #2 Parallel Debug @[z eleo[QRA[d Fole-=0
processes

+ Click on the Step Over
button

Open_MPI@abe.ncsa.uiuc.edu: def

5 2 59 = O] i+ B | e ¥ =08
+ Observe that all process 2 X _— S
. v i-tshallow [Parallel Application]
icons change to green, v & Process 0
then back to yellow e —
+ Notice that the current i}
line marker has moved to "™ 8

float  h[n][];
" 3t

tan((double)1.);

the next source line \

~tpi/(float)m;
float  dj-tpi/(floatdn;
int 1, j, chunk_size, nxt, prv;

int master_packet[4];
float  p_start[n];
float  u_star

float  v_:
float  psi_start[al;
float  pold_start[n);
float  uold_start[m);
float  vold_start[ml:

Module 6

Stepping An Individual Process

[ XeXe) PTP Debug - shallow/main.c - Eclipse SDK.
+ The buttons in the r3- @ %08 Q- O 5= B #7850 G & gBPTec
Debug view are Used 15 Parallel Debug &2 il 1EX: [CRAES o' {2} = O % Breakpoints |
Open_MPi@abe.ncsa.uiuc.edu: default:;job0 - Root [4]
to control an

£3job0 vy Name
individual process, in Sargy
this case process 0 —— S0

P - = s 2| & Tea||reu
+ Click the Step Over sl e Al T
button v ® Thread [1] (Suspended) ———

+ You will now see two ‘
current line markers,

the first shows the e N
position of process 0, float  sumitiy;
the second shows the float  pioe *CFloatatan(Cdoubledt.d;

positions of processes 2 float  dreept/crioatym;
1_3 / float dj-tpi/(float)n;

int i, j, chunk_size, nxt, prv;

int master_packet[4];
float  p_start[m];
float  u_start[m];
float  v_start[m);
float  psi_start[m];
float  pold_start(m];
float  uold_start[n];
float  vold_startfm]:
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Process Sets (1)

+ Traditional debuggers apply operations to a single
process

+ Parallel debugging operations apply to a single process
or to arbitrary collections of processes

+ A process set is a means of simultaneously referring to
one or more processes

Module 6 6-6

Process Sets (2)

+ When a parallel debug session is first started, all
processes are placed in a set, called the Root set

+ Sets are always associated with a single job
+ A job can have any number of process sets

+ A set can contain from 1 to the number of processes in
a job

Module 6 6-7




+ Debug operations on the

Operations On Process Sets

Parallel Debug view

toolbar always apply to the [#ridomus b @l o w0 & o ol0=0
Open_MPl@abe.ncsa.uiuc.edu: default;job0 - Root (4]
current set: £2job0 A
+ Resume, suspend, stop,
step into, step over, step
return a0 it L - T°e

5-+shallow [Parallel #pli

The current process set is e
. . ¥ of reg
listed next to job name = + main) main.c:49 2cc5

along with number of
processes in the set

The processes in process
set are visible in right hand
part of the view

Root set = all
processes

Module 6 6-8

Managing Process Sets

+ The remaining icons in the toolbar of the Parallel
Debug view allow you to create, modify, and delete
process sets, and to change the current process set

Create set Remove
\ f/rom set
B parallel Debug 3 YNDIEENIERIEEIrE =]
Open_MPI@abe.ncsa.uiuc.edu: default:;job0 - Root [4] \ Cha nge
£2job0 o> > > current set
5 Debug £ o> A ‘i = [ veg Delete
v &% shallow [Parallel Application] set

v &@Process 0
v ;@ Thread [1] (Suspended)
= 1 main() main.c:49 2cc5

Module 6 6-9




Creating A New Process Set

Select the processes
you want in the set by
clicking and dragging,
in this case, the last
three

Click on the Create
Set button

Enter a name for the
set, in this case
workers, and click OK
You will see the view
change to display only
the selected processes

@ Parallel Debug
Open_MPI@abe.ncsa.uiuc.e:

£3job0

Module 6

i Parallel Debug &3 B || 2. G 0| o~ =-=0
Open_MPI@abe.ncsa.uiuc.edu: default:job0 - Root [4]

job0 ——irs) 1

Create a new set name

%5 Debu | Please enter the new set name. j

#ehallow [Parallel Appli "o

v &@Process 0 (Suspend

v ;@ Thread [1] (Susp .
1 main() main (__Cancel oK
0 @[3 060 A8 |¢-Ffo @8

1w vw

fault:job0 - workers [3]

Stepping Using New Process Set

With the workers set
active, click the Step

Over button

You will see only the
first current line
marker move

Step a couple more
times

You should see two line
markers, one for the
single master procesy/
and one for the 3
worker processes

Module 6

800 PTP Debug - - Eclipse SDK.
| 350 0 Q- Qe | O 32 ] REPTP Debug EEPTP Runtime [C/C++
iialiel O —l @ 0 R L 07 (¢ |83+ = B)[% Breakpoints |47 Expressions ®9- Variables £ <8
Open_MPIGabe.ncsa.uiuc.edu: default Job0 - workers (3] z -
1 Debug 3 <=0
4 shallow [Parallel Application]
2 = 0)(2 Outline =
- % * b
o mathh
|
o stdioh
o decs
worker(): void
setup_res0 : MPL_Dataty’
main(int, char*(})
tup_res( : MPI_Dataty
update_global_ds(MPI_C
*  WPLInit(Sarge
© console| 0 Memory @) rror Log & (& Problems BEEY =0

Master SOM control
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Process Registration

+ Process set commands apply to groups of
processes

+ For finer control and more detailed
information, a process can be registered and
isolated in the Debug view

+ Registered processes, including their stack
traces and threads, appear in the Debug view

+ Any number of processes can be registered,
and processes can be registered or
un-registered at any time

Module 6 6-12

Registering A Process

+ To register a process,

double-click its process 800 PTP Debug - shallow/main.c - Eclipse SDK.

o %50 @r Qe | O |22 e

icon in the Parallel )
- 28 Parallel De}
Debug view or select @  open wrigabencsauncs

j0b0 - Root (4]

[ R &0 S [ {2+ < O|[% Breakpc

number of processes and  “#*° o @ Groups (sets) —
click on the register of processes b o uoy
button ) ) % Debug £ LI EX- iv B [ & ve=n »3
+ The process icon will be VS sl sk Apphcatin e
v @ Process uspende ..
surrounded by a box and 7@ Tvead ] Guspended) Individual puold
the process appears in 'é@?/;c;c:ssi(s;sspend.ed‘: ) (rergol(s:‘;es;eecl)
= ¥ ;@ Thread [1] (Suspended)
the Debug view T T ——
+ To un-register a process, . munc=
dOUble‘CIiCk on the float vold startlml:

process icon or select a
number of processes and
click on the unregister
button
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Current Line Marker

+ The current line marker is used to show the
current location of suspended processes

+ In traditional programs, there is a single
current line marker (the exception to this is
multi-threaded programs)

+ In parallel programs, there is a current line
marker for every process

+ The PTP debugger shows one current line

marker for every group of processes at the
same location

Module 6 6-14

Colors And Markers

+ The highlight color depends on it gy
the processes suspended at
that |ine: » ;Li:é:;;i?:zﬁpﬁ;aﬁiuonm, &proc_cnt);

MPI_Comm_rank(MPI_COMM_WORLD, &tid);

+ Blue: All registered process(es) S
+ Orange: All unregistered {
process(es) WPI_Fin

+ Green: Registered or unregistered ’
process with no source line (e.g. .
suspended in a library routine)

% Multiple processes marker
+ The marker depends on the

type of process stopped at that |» Registered process marker
location

®» Un-registered process marker
+ Hover over marker for more
details about the processes »
suspend at that location

Multiple markers at this line
-Suspended on unregistered process: 2
-Suspended on registered process: 1

Module 6 6-15

fprintf(stderr, "must have at least 2 processes, not ¥d\n", proc_cnt);
alize();




Breakpoints

+ Apply only to processes in the particular set that is
active in the Parallel Debug view when the breakpoint
is created

+ Breakpoints are colored depending on the active
process set and the set the breakpoint applies to:

+ Green indicates the breakpoint set is the same
as the active set.

+ Blue indicates some processes in the breakpoint set are
also in the active set (i.e. the process sets overlap)

+ Yellow indicates the breakpoint set is different from the
active set (i.e. the process sets are disjoint)

+ When the job completes, the breakpoints are
automatically removed

] else{
) print:
J MPI_Final
Module 6 6-16

Creating A Breakpoint

eno PTP Debug - shallow/main.c - Eclipse SDK
V#5000 Qe | O |22 g
+ SeleCt the p!‘ocess Set that 22 Parallel Debug 2 @2 G ® 0K O (F (3| 2 = B [% Break
the brea kpolnt Should apply Open_MPi@abe.ncsa.uiuc.edu: default:job0 - workers (3]
t . th th k £2job0 1 @ Name
o,tln is case, the workers uo
se o
+ Double-click on the left edge  #omss T TIEX: #[6[c"=5) »ov
: . vis rallel ication] Easipsl
of an editor window, at the B process s Guspunded) o4
. - Py » & uol
line on which you want to set R e A

the breakpoint, or right click
and use the Parallel

Breakpoint» Toggle
Breakpoint context menu i

+ The breakpoint is displayed o U CHK Grocent - 1) 12 0)
on the marker bar T arceo)

0)
tf(stderr, "(number of processes - 1) must be a multiple of %d\n", n);

& console ) Memory| €] Error Log 2 |2 Problems

Writable Smart Insert 78:12
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Hitting the Breakpoint

(. Xeo} PTP Debug - shallow/main.c - Eclipse SDK
Click on the Resume button ~ _° = =o@ on =000 0 o e
in the Parallel Debug view ot g et s 0 - om0
In this example, the three ’ Suse
worker processes have hit the X
breakpoint, as indicated by T e e LI oo
the yellow process icons and Y s o e ez Sl
the current line marker e R
Process 0 is still running as its .
icon is green e
Processes 1-3 are suspended 4 Coment <2
on the brea kpo|nt fprintf(stderr, "must have at least 2 processes, not %d\n", proc_cnt);

MPI_Finalize();
return 1;
}
@ | if ((n % (proc_cnt - 1)) 1= 0
if (tid - 0)
fprintf(stderr, "(number of processes - 1) must be o multiple of %d\n", n);

WPI_Finalize();

& console | 0 Memory| @) Error Log % (£ Problems

Module 6 7 6-18

More On Stepping

e 00 bug - shall
The Step buttons are only ~ “ —— T———
enabled when all processes 8% 0% QO JEZ]B P ]ori-e e

in the active set are 7 parallel Debug 2 53 0| o
suspended (ye| IOW icon) Open_MPl@abe.ncsa.uiuc.edu: default;job0 - Root [4]
. s B @
In this case, process 0 is still
running
PTP Debug - shallow/n
Switch to the set of @ %078 QO |0 e
suspended processes (the £ Parallel Debug X - N CNEN A
w rk r Open_MPl@abe.ncsa.uiuc.edu: default:;job0 - workers [3]
orkers set) e e

You will now see the Step
buttons become enabled

Module 6 6-19
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Breakpoint Information

+ Hover over breakpoint icon

+ Will show the sets this breakpoint applies to
+ Select Breakpoints view

+ Will show all breakpoints in all projects

% Breakpoints £3 . 57 Expressions| ®)= Variables =08

Y ENEERIEIEN
IZ‘ @ main.c [line: 78] {jobO:workers}

Module 6 6-20

Breakpoints View

+ Use the menu in the breakpoints view to group
breakpoints by type

+ Breakpoints sorted by bredkpoint set (process
set)

9 Breakpoints £2 . &7 Expressions )= Variables =g
T ENEERIEIEE
™ v ., workers Add Event Breakpoint (C/C++)...
» main.c [line: 78] {jobO:workers}
Group By i@l % 1Breakpoints
oo Select Default Working Set... &5 2 Breakpoint Types
oo 3 Breakpoint Working Sets

Working Sets... 4 Files
1 Show Qualified Names v ¢ 5 Parallel Breakpoint Set

= 6 Projects
& Focus on Active Task (= 7 Resource Working Sets
n & 8 Advanced...

Module 6 6-21
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Global Breakpoints

+ Apply to all processes and all jobs
+ Used for gaining control at debugger startup
+ To create a global breakpoint

+ First make sure that no jobs are selected (click in white
part of jobs view if necessary)

+ Double-click on the left edge of an editor window

+ Note that if a job is selected, the breakpoint will apply to
the current set

& ] if (my_rank !=0) {
¥ create message *

sprintf(message, "Greetin

Module 6 6-22

Terminating A Debug Session

[sJeXe) PTP Debug - shallow/main.c - Eclipse SDK
+ Click on the Terminate |'* 1 [$-0-2- Q- O = g
icon in the Parallel —= L > KAo- ) O

q

- Open_MPI@abe.ncsa.uiuc.edu: default:;job0 - Root [4]
Debug view to FITTI . ¢ ¢ ¢ ¢

terminate all processes
in the active set

+ Make sure the Root set
is active if you want to
terminate all processes

%5 Debug 2 iv B [ & T = [l

-} <terminated>shallow [Parallel Application]

800 PTP Debug - shallow/main.c - Eclips
w0 | 35 Qv Qv Qur | O~ | 52
2 Parallel Debug % il 1EX- ® 0K o' ®-=8
+ YOU Cal’l a|SO use the gp}e:g:vl@abmcsaumcedu dezal;I_llAc:boy- R::ol 4)
terminate icon in the
Debug view to _
R 7 Debug — & iv 3 | €3 v=0a
terminate the currently |7 iow e assicaion

v @ Process 0

selected process

v Thread [1) (Suspended)
= 1 main() main.c:49 2ccS

Module 6 6-23
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Module 7: Advanced Development

+ Objective

+ Explore some of the advanced features of Eclipse and PTP
+ Contents

+ Advanced Eclipse Concepts (generic, not CDT/PTP)

+ Refactoring and Search in Fortran and C/C++

+ Parallel Language Development Tools: MPI, OpenMP, UPC

+Special Tools for parallel development
+ Remote Development

Module 7 7-0

Advanced Eclipse Concepts

+ Perspectives, views and customizing
+ Workbench Preferences

+ Version Control

+ Task Tags

Module 7 7-1




Customizing Perspectives

+ Items such as shortcuts, menu items and views may be
customized

+ Window» Customize Perspective...
+ Save changes

+ Window»Save Perspective As...
+ Close Perspective

+ Right-click on perspective title and select Close
+ Reset Perspective

+ Window» Reset Perspective resets the current
perspective to its default layout

Module 7 7-2

Opening New Views

e —
+ To open a view:
+ Choose Window»>Show View»Other..| 5o
+ The Show View dialog comes up éf"jéj:jea"h
+ Select the view to be shown @) Error Log
Internal Web Browser
+ Select OK ;Mam
. Navigator
2= outline
2( Problems
& Progress

L5 Project Explorer

E Properties

Use F2 to display the description for a
selected view.

Cancel
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Workbench Preferences

+ Preferences provide a way for you to
customize your Workbench

+ By selecting Window » Preferences... or
Eclipse»Preferences... (Mac)

+ Examples of preference settings

+ Use Emacs bindings for editor keys

+ Modify editor folding defaults
+E.g., fold all macro definitions

+ Associate file types with file extensions
+E.g., *.f03 with the Fortran editor

+ Toggle automatic builds

+ Change key sequence shortcuts
+E.g., Ctrl+/ for Comment

Module 7 7-4

Version Control
(Eclipse Team Support)

+ Version control provided = M“‘;\ T —
through the Project ! )
Explorer view, in the
Team context menu

+ Provides familiar
actions:

+ Commit...
+ Update...
+ Also less used tasks:

+ Create/Apply
Patch...

+ Tag as Version...

+ Branch...

+ Merge...

+ Add to .cvsignore...
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8no e izing - CVS (mpac): /mpac/Makefile - Eclipse.

Accessed from the
Team»Synchronize |r=®
with Repository [l
context menu
Shows: N

+ Files to be added e om0 =3

+ Files to be updated s ;

+ Files to be committed

+ Files to be deleted

+ Merge conflicts
Double-click on file to AT
show compare viewer
Operations can be
performed on individual e i 4
files or all at once

README

7
# Added comment
t

SR
SRCOIR-S;

'TOPOIR:
SRCOIR
SRCOIR-S LOCALMAKEFILE .OPTIONAL = yes.

Location

Module 4 7-6

Task Tags

L) MySampleProject.c 22

+ Task tags are identifiers in C/ : B
C++ comments o pan e

+ TODO is a built-in task tag

+ The build locates task tags
during compilation

+ View task tags in Tasks View

+ If it's not shown, Window : 158/ pranes)aarnelvetaels
» Show View » Other... .

a th cask ta :v:.—.@ike chis

< >
Open General and select ¢ v Gom C @
Fiter matched 3 of 8 items.
Tasks v 1t besooten Resasce | o
MyTag a sample task tag MySamplePr... MySampleProject/src line 17
H MyTag like thi MySamplePr... MySampleProject/src line 8
+ Configure your own task tag T000 e s btttk 9 WSaroirr. WoampeoRe ine 19

in Window » Preferences
+ Under C/C++, select Task
Tags
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Refactoring
and
Search
in Fortran and C/C++

Module 7

Refactoring

(making changes to source code that don’t affect the behavior of the program)

= et + Refactoring is the research

o oM motivation for Photran @ Illinois
"

« Illinois is a leader in refactoring research
Extract Local Variabié--

ol ) . .
MPLICIT NONE... + "“Refactoring” was coined in our group
Introduce | (Opdyke & Johnson, 1990)
Variable..- . . .
Encapsulate - + We had the first dissertation...
Make Privaté En(in::llljl;:(;l;(emen(... (Opdyke, 1992)
lause . . .
Add o_riLeVoCN:Y List. p— + ...and built the first refactoring tool...
inim!. 0
Min MMoN Var:ab"? %‘;;"I:(SJN B (Roberts, Brant, & Johnson, 1997)
Make Covg variables 0 ¢ + ...and first supported the C preprocessor
Move SA LoopS (unchecked) i (Garrido, 2005)
nge L0 .
|ntercha st o + Photran’s agenda: refactorings for HPC,
Unify K:vowbsolete oper® language evolution, refactoring framework
Replac
ing)
(Debu9d’ . :
+ Photran 5.0: 10-15 refactorings
]
Module 7 PTP Tutorial
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Rename Refactoring

+ Changes the name of a variable, function, etc.,

including every use

(change is semantic, not textual, and can be workspace-wide)

+ Only proceeds if the new name will be legal
(aware of scoping rules, namespaces, etc.)

C/C++ - MyHelloProject/src/MyHelloP
File Edit §ourceuavigate Search Proje

Rename... Shift+Alt+R |

S~ (Debugging)

+ Select C/C++ Perspective or
Fortran Perspective

+ Open a source file

+ Click in editor view on
declaration of a variable

+ Select menu item

[ Fortran Rename... ’
Refactor» Rename
Extract Procedure... A
$5Fol  Bxract Local Variable... ' + Or use context menu
4+ Enter new name
Module 7 PTP Tutorial 7-10

Extract Procedure Refactoring

+ Moves statements into a new subroutine, replacing the
statements with a call to that subroutine

+ Local variables are passed as arguments

2 Extract Procedure

Changes to be performed
4 W& Edract
7R

[ gauselim.f0 S A 8a

real ::
integer ::
integer ::

[ <Bax |[ o [ conce |

Module 7

PTP Tutorial

+ Select a sequence of statements

| + Select menu item

Refactor» Extract Procedure...

in Fortran, or, in C/C++,

Refactor» Extract Function...
+ Or use context menu

+ Enter new name




Photran Implicit Refactoring

+ Introduce Implicit None adds an IMPLICIT NONE statement
and adds explicit variable declarations for all implicitly
declared variables

2 Introduce Implicit None

[[crenges tobe petomea Tl + Introduce in a single file by
e e _— ‘ opening the file and selecting
Refactor» Introduce IMPLICIT
NONE...

[F) gauselim.90

| |Original Source Refactored Source

L ussianEliminati
! Solve a linear system o
and Back Substituction

program GaussianElimi: -
implicit none
integer :: indx
integer :: jndx
integer :: kndx
integer :: lndx
! Always declare ALL vari integer :: nsize
REAL :: amtx(10,10) ! Solve a linear syst{
REAL :: bvce (10) ! and Back Substitu{ _

+ Introduce in multiple files by
selecting them in the Fortran
Projects view, right-clicking on
the selection, and choosing
Refactor»Introduce IMPLICIT

o) o) | NONE...

! SUBROUTINES: mtxrd,mtxw

» < [ »

e
=
o
3

Module 7 PTP Tutorial 7-12

CDT Rename in File

| example.cc £3

+ Position the caret

public:
+ Press Ctrl+1 Pfi_;éi:é:;,
(Command+1 on Mac).
int getX();
+ Enter a new name. void setX(int x);
ChangeS are private:
propagated within }f“* x)

the file as you type

Module 7

int MyClass)::getX() {

return X i

over an identifier. | class pyclass (

}
void MyClass)::setX(int x) {
x_ = x;
}
|
PTP Tutorial




"
Il

CDT Extract

800

The following changes are necessary to perform the refactoring.

int main(void) {

Changes to be performed

Refactoring double intvalue-0,0}
Source > ” l ‘
Refactor » Rename... 4R
Declarations > Extract Constant... \XC
ey b

M v & Changes
™

@' MyCproject.c - MyCproject/src

ther refactorings that

~

are planned:
MyCproject. .
SV IRRSE I + Extract Function
Original Source Refactored Source . .
#include <stdio.h> #include <stdlib.h> rall + Hide Member Function
#include <stdlib.h> i i
_{SHatic const ot WEERU="0.0; ] + Move Field or Member Function
Tnt main(void) { [int main(void) { ] + Extract Subclass
double intvalud double intvalue-MYZERO;
puts("111Hello "y; 7% prints | puts("111Hello World!11"); /% prin + Extract Baseclass
return EXIT_SUCCESS return EXIT_SUCCESS;
} } o + Separate Class
int foo(){ int foo(){ ;
double myin double myint-MYZERO; + Implement Function
i ‘ ‘} + Declare Function
. . . H + Move Function Definition
TS TSy
+ Generate Getters and Setters

[
C =Bk ) (News ) (Gancel ) %

Module 7

PTP Tutorial

Search

)7 FileSearch | 5 C/C++ Search | E§? Fortrag,

Search string (* = any string, ? = any character):

“Knows” what things can
be declared in each
language (functions,
variables, classes, o
modules, etc.) 7

fich | )’ Java Search | % Plug-in Search |

C/C+...

Fortran...

get* v [ Case sensitive |
Search pattern:
Search For LimitTo . ot
et v egular expression
Class / Struct (¥ Function Variable Declarations "] Definitions 9 guiar e
| Union 7| Method Field 7|References [ All Occurrences = any string, 7 = any character)
( Enumeration Enumerator [ | Namespace | Search for Limit to
Typedef Macro Any Element ‘ Common block (7] Function All occurrences
‘ V| Subroutine Module Declarations
Scope | | Varisble Program o References
® Workspace Selected resources Enclosing projects |
Working set: Choose... Scope
© Workspace Selected resources ) Enclosing projects
Working set: Choose...
| @ [ customize.. Search Cencel |
I J |
ey ey e - . P
| @) [ customize... Search || Cencel |
! |mCustomize - Lacorch ) |mmCancel oy
Module 7 PTP Tutorial 7-15

Window F
9 Search.  CuleH + E.g., search for every call
[ File.. to a function whose name
Text ’ starts with “get”

J File Search | &

+ Search can be project- or
workspace-wide

C/C++ Search| 557 Fortran Search |7 Java Search | %7 Plug-in Search




Open Declaration

+ Jumps to the declaration
of a variable, function,
etc., even if it'sin a
different file

+ Right-click on an identifier
+ Click Open Declaration

Module 7

[F] gauselim.f30 &2

write (%, *) 'A Matrix:'
call mtxrd (fmes——simm—meimns
call mtxwrt

write (%, *
write (*, *

Open Declaration F3

Show In Alt+Shift+W »

Tip: Open Declaration works
in C/C++, and it works in
Fortran, but it cannot jump
“across languages”

PTP Tutorial 7-16

Parallel Lang. Dev. Tools

+ PLDT Features

+ Analysis of C and C++ code to determine the location
of MPI, OpenMP, and UPC Artifacts

+ Content assist via ctrl+space (“completion”)

+ Hover help

+ Reference information about the API calls via Dynamic

Help

+ New project wizard automatically configures managed
build projects for MPI & OpenMP

+ OpenMP problems view of common errors

+ OpenMP “show #pragma region” , “show concurrency”

+ MPI Barrier analysis - detects potential deadlocks

Some MPI features were covered in Module 4

Module 7




OpenMP Managed Build Project

+ If you haven't set up
OpenMP preferences e.g.
include file location, do it
now

+ Create a new OpenMP
project
+ File»New »C Project
+ Name the project e.g!

: ® MPI Empty C Projec
‘MyopenMPprOJeCt, P 'OponMPp:ello‘;Zdalc Proj
-~ © OpenMP Empty C Project
+ Select OpenMP Hello World C St oy
Project & Staic Library 5

+ Select Next, then fill in other
info like MPI project

(v]] L))
C Project
Create C project of selected type

Project name: | MyOpenMPproject

[¥] Use default location

Location: |/home/tibbitt runtime-pldt20/MyMPlproject Browse

Project types: Toolchain:

© Hello World C++ Project

@ Hello World ANSI C Project
® Empty Project

© MPI Hello World C Project

1 I—Z—
Show project types and toolchains only if they are supported on the platform

E | wea> |[ Einish Cancel

Module 7

Setting OpenMP Special
Build Options

special compiler options.
+ Open the project

properties //v
+ Select C/C++ Buily 5
+ Select Settings

+ Select C Compiler

S Properties for MyOpenMPproject =/%]

+ OpenMP typically requires |[imoee Settings

-~
Configuration: |Dedug v @

&) Tool settings | #* Buid steps Buid artifact | ai§ Binary parsers | ©

Other fiags | ¢ -fmessage-ength=|
2 [verbose ()
P Clsupport ANST programs (-ansi)

+1In Miscellaneous,
add option(s).

Module 7
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+

+

Show OpenMP Artifacts

S C/C++ - MyOpenMPproject/src/MyOpenMPproject.c - Eclipse SDK - C-\ews\runtime-temp = X]
File Edt Refactor Navigate Search Project Run Window Heb

3~ &l T R AT AR CAd F-0-Q- O~ [ %5 Debug |Fjc/c++ | & ava
> ms m

Select source file, |Crmeme s =6/ mommmomc =B|fo % =5

. o % double -~ AR o
folder, or project oS totrces W o
® @) Indudes I - U stngh
. B8 src - U stdib.h
Run ana|ys|s h co » if (omp_in_pararlel)( oS
A L] printe( ) .
® 5 MyOpenMPproject 5 U openmp.h
&) Indudes o manint, chr
5B o
B » ize * sizeof (dov
td MyOpenhPproject.c y = (double *) malloc( ( ) ( arraySize * sizeof (do
® (& Debup
O -0 e ratoen gep e chat paraliclizes the foriof Iy
= P #pragma omp parallel for
B> Show MPI Artifacts for (1= 0; 1< arraySize; is+)
’shov\vocrenMPAmfacis R y[i] = sin( exp( cos( - exp( sin(x[i]) ) ) ) ):
}
473 MP1 Barrier Analysis retarn 0;
< > < >

i i B e e e of Artfact view 73 =g
See artifacts in Lt :

i %3
OpenMP Artifact i I — o E
- W spragma omp paralel for MyOpenMPproject.c 34 ol
view N
<] >
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Run OpenMP
analysis ’ *pr;g;: m'n; ;;:ailé;.{;oi:a;n& that parallelizes the for-lo =
R|ght Cllck on fo:‘ (i=0; i< arraySize; i++ )

H y[i] = sin( exp( cos( - exp( sin(x[i]) ) ) ) ):
pragma in y

artlfact VleW , return 0;
(v
(<] m ‘ Bl <

[2. Problems | | Tasks | E] Console Debug | @ OpenMP Problems ’ OpenMP Artifact View &3

S e I e Ct s h ow OpenMP Artifact Filename LineNo
p ra g ma reg ion omp_in_parallel MyOpenMPproject.c 26
#>{ #pragma omp parallel for T pjecte 34

Show pragma region

See highlighted region in C editor
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Show OpenMP Problems

S C/C - proj pe - Eclipse SDK - C:\ews\runtime-temp Lo
Fle Edt Refactor Navigate Search Project Run Window Help
S| @8- [§-F RO~ £ %5 Debug

+ Select OpenMP
problems view

+ Will identify standar
OpenMP restrictions

# > Debug

P g em bemmier pesE probles =

$-0-a- O

M@ il-e g cic++ | & ava
(25 Project Explorer &3 O|( [e) *MyopenmPproject.c | [c] openhPproblems.c 53 =a
» #pragma omp parallel for &

for(3=1; 3<10; 3++)

int 1, 3;

v

[2. Problems | Tasks 5 Console | @ OpenhP Problems 2 ¥ OpenlP ArtifactView| — [
i -

Description Re!

® For directive embedded within another paralel for or paralel sections o1

@ Barrier directive not permitted in region extent of for, ordered, sections, snle, master, and critical  op:

< >
Writable Smart Insert 26:5

Module 7
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Show Concurrency

+ Highlight a statement

+ Select the context menu
on the highlighted
statement, and click
Show concurrency

+ Other statements will be
highlighted in yellow

+ The yellow highlighted
statements might execute
concurrently to the
selected statement

Module 7

int simple(Q{
#pragma omp parallel
{

3

=1
=2
=3
-4 b

oo oo

1
}

int simple2(){
#pragma _omp parallel
{

a=1;
b=2;
#pragma omp barrier
b=3;
a=4;

7-23
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UPC Support

+ To see UPC support in C

editor, install the optional Under Optional Features
feature from CDT ——, 7 4§ Unified Parallel C Support
+ See Also:

http://wiki.eclipse.org/PTP/other_tools_setup#Using_UPC_features

+ Filetypes of “upc” will MIETES3:Es 4/ private varidbtes

get UPC syntax high- eewiicg_the matrix a[1[]
lighting, content assist, £-0; 1<N; iee; &a[i1[0])

O CJ-9; J<P; j++
etc. aliI[j1-i*P+ie1;
+ Use preferences to ialise the matrix LD
change default for *.c upc_forall(j=0; j<M; j++; &b[OI[31)

if you like for (i-0; i<P; i+4)
b[1][3]-3%2;
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Remote Development

+ PTP already provides the ability to launch/debug
remotely
+ However it is often desirable to be able to edit and build remotely
+ If projects are very large, build times may be considerable

+ The PTP Remote Development Tools (RDT) will provide
a complete remote development environment

C/C++ (and Fortran) projects can be hosted on a remote machine

Eclipse runs on your local workstation or laptop

Files are pulled to local machine only for editing

Remote indexing and other services are performed remotely

Both managed and Makefile projects are built remotely

Uses either Remote System Explorer (RSE) or PTP’s Remote Tools

Will have the ability to tunnel over ssh connections

4+
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Remote Development (2)

+ RDT was introduced with PTP 2.1
+ Configuration is separate from PTP configuration
+ Restricted to RSE connections only (no tunneling)
+ Manual server launch
+ PTP 3.0 will seamlessly integrate RDT configuration and
simplify setup and use
+ New service model combines PTP and RDT configuration
+ New project wizard has been enhanced and simplified
+ Automatically launch remote server process
+ Still under active development

So we won't cover it today

Module 7 7-26
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Module 8: Other Tools and
Wrap-up

+ Objective
+ How to find more information on PTP
+ Learn about other tools related to PTP
+ See PTP upcoming features
+ Contents
+ Links to other tools, including performance tools
+ Planned features for new versions of PTP
+ Additional documentation
+ How to get involved

Module 8 8-0

IYNESA  HpcC Workbench

+ Tools for NCSA Blue Waters

+ http://www.ncsa.illinois.edu/BlueWaters/
+ Sustained Petaflop system .

+ Based on Eclipse and PTP n : rrn
+ Includes some related tools ‘ m

——

+ Performance tools
+ Scalable debugger
+ Workflow tools (https://wiki.ncsa.uiuc.edu/

display/MRDPUB/MRD+Public+Space+Home
+Page)
+ Part of the enhanced computational environment
described at:
http://www.ncsa.illinois.edu/BlueWaters/ece.html

SUSTAINED PETASCALE COMPL
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Coding &

s NCSA HPC Workbench

(CDT, PLDT,

PTP
Photran) - Launching &
e ~ Monitoring
= 1 . w\“:m i
Performance TR =
= - P Tuning =
’ —agi ¥ = (HPC toolkit,
' HPCS toolkit,
= Al . RENCI, ...) _
S PTP Debugging
Module 8

PTP-Related Tools

+ External Tools Framework

+ Formerly Performance Tools Framework
+ Tuning and Analysis Utilities (TAU)
+ ISP - In-situ Partial Ordering

+ MPI analysis tools from U.Utah
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PTP/External Tools Framework

formerly “Performance Tools Framework”

- <tool

Goal:

+ Reduce the “eclipse plumbing”
necessary to integrate tools

+ Provide integration for
instrumentation, measurement, and
analysis for a variety of performance
tools

+ Dynamic Tool Definitions:
Workflows & UI

nd=
<utility command =
~<optionpane title:

+ Tools and tool workflows are
specified in an XML file

+ Tools are selected and configured in
the launch configuration window

+ Output is generated, managed and
analyzed as specified in the
workflow

Module 8 8-4

8 Show Reachable

PTP TAU plug-ins >

www.cs.uoregon.edu/research/tau/home.php

+ TAU (Tuning and Analysis Utilities)

+ First implementation of Performance Tools Framework

+ Eclipse plug-ins wrap TAU functions, make them
available from Eclipse

+ Compatible with Photran and CDT projects and with
PTP parallel application launching

+ Other plug-ins launch Paraprof from Eclipse too

&

=t
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ISP - In-situ Partial Order )

+ Being contributed to PTP by U. Utah
+ Hope to make available in PTP 3.0 (late Oct.)

+ Analyses MPI code dynamically for deadlocks, etc.
+ Can match sends and recieves

+ Can work with several different MPI
implementations

Module 8 7-6

Applications

* Verifies MPI User Applications, generating
= only the Relevant Process Interleavings

* Detects all Deadlocks, Assert Violations,
MPI object leaks, and Default Safety Properties

» Works by Instrumenting MPI Calls
(BIueGen\e/L - Image courtesy of IBM/LLNL) 4 ComPUting Relevant InterleaVingS, Replay]ng

HEa

=
gle




Eclipse CDT/PTP based ISP GUI e

ISP Plug-in (trident icon) based on CDT and PTP It also allows viewing of MPI

allows PostVerification Review of Happens-Before Relation - a

Relevant Interleavings, and highlights bugs succinct summary of the
o o required MPI orderings

For details, including Beta download, please visit -8
http://www.cs.utah.edu/formal_verification/ISP-Eclipse

Useful Eclipse Tools

+ Python
+ http://pydev.sourceforge.net
+ Ruby
+ http://sourceforge.net/projects/rubyeclipse
+ Subversion (now an Eclipse project)
+ http://eclipse.org/subversive
+ Git (now an Eclipse project)
+ http://www.eclipse.org/egit
+ ... and many more!
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Future PTP Features

+ Support for multicore development
+ Building on Cell IDE and other multicore tools
+ Resource managers to support for PBS, LSF,
and Blue Gene
+ Transitioning debugger to Scalable Tools
Communication Infrastructure (STCI)
+ Enhancements to ETF to support compiler
generated reports and optimization directives
+ Scalability improvements
+ UI to support 1M processes
+ Optimized communication protocol
+ Very large application support

Module 8 8-10

Information About PTP

+ Main web site for downloads, documentation, etc.
+ http://eclipse.org/ptp

+ Developers’ wiki for designs, planning, meetings, etc.
+ http://wiki.eclipse.org/PTP

+ Articles and other documents:
+ http://wiki.eclipse.org/PTP/articles
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Mailing Lists

+ PTP Mailing lists
+ Major announcements (new releases, etc.) - low volume
+ http://dev.eclipse.org/mailman/listinfo/ptp-announce
+ User discussion and queries - medium volume
+ http://dev.eclipse.org/mailman/listinfo/ptp-user
+ Developer discussions - high volume
+ http://dev.eclipse.org/mailman/listinfo/ptp-dev
+ Photran Mailing lists
+ User discussion and queries
+ http://dev.eclipse.org/mailman/listinfo/photran
+ Developer discussions -
+ http://dev.eclipse.org/mailman/listinfo/photran-dev

Module 8 7-12

Getting Involved

+ See http://eclipse.org/ptp
+ Read the developer documentation on the wiki
+ Join the mailing lists

+ Attend the monthly developer meetings
+ Teleconference each second Tuesday, 1:00 pm ET

+ PTP will only succeed with your participation!
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PTP Tutorial Feedback

+ Please complete feedback form
+ Your feedback is valuable!

Thanks for attending
We hope you found it useful

Module 8
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Cluster 2009: 8/31/09 Developing Scientific Applications Using Eclipse
Tutorial Feedback and the Parallel Tools Platform

Thank you for attending our tutorial/workshop. As a part of an on-going effort to improve the
utility and usability of the tools we are developing, we are asking attendees to answer the
following questions. Note that all answers are anonymous. Comments are welcome anywhere.

1. Eclipse - how useful does Eclipse in general seem to you? (CIRCLE ONE)
1 2 3 4 5
very useful Neutral very useless

2. PTP: How useful does the functionality represented by this tool seem to you?
1 2 3 4 5
very useful Neutral very useless

Would you expect to increase your productivity by using this tool? If so, how much of an
increase in productivity do you think you may achieve by using this? Why?

3. Usability: How usable do you think the tools are with their current interface?
1 2 3 4 5
very usable Neutral very unusable

Was there anything in particular that you found confusing or counterintuitive? If so, what?

Do you have any suggestions for improving the user interface or additional functionality?
Please describe:

4. Other tools?

What other tools would you like to see developed that would have a large impact on your own
productivity?

What other tools would you like to see developed that would have a large impact on the
performance of the applications you work on?

5. Tutorial presentation

How useful was the content of the workshop to your current position?
1 2 3 4 5
very useful neutral very useless

How well presented was the information?
1 2 3 4 5
excellent fair satisfactory not so good unacceptable



Cluster 2009: 8/31/09 Developing Scientific Applications Using Eclipse
Tutorial Feedback and the Parallel Tools Platform

How well did the instructors handle questions?
1 2 3 4 5
excellent fair satisfactory not so good unacceptable

Is there other material you would have liked to have had presented? If so, what?

Is there material you think should be deleted? If so, what?

6. Your Background:
How many years experience do you have in the IT industry? In HPC?

List languages in which you have written significant programs:
Which is predominant currently? Why?

Do you currently use an IDE (Integrated Development Environment, e.g. Eclipse)? If not, why?

What is your current job role?

Can you describe the major application(s) you are working on now?

Can you describe what you see as the major bottlenecks to increased productivity where you
work?

Are there any other relevant comments you want to share?

Optional) Name: Email:
(Op

Thank you for your feedback!
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